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1 Power System Network Editor 

Power System Network Editor is a general-purpose graphic user interface designed to create a 
power system single line diagram and any other general diagram using the preliminary drawing 
elements. MiP-PSCT’s Network Editor is equipped with tools and features designed to make the 
creation of the network easy. The commands to select the various options are configured as menu 
items. Easy selection and editing of the network components using toolbars help the user for faster 
creation of the single line diagram. Further grouping of the objects, copying, moving and deleting 
commands are provided for faster creation of the single line diagram. The user can selectively set 
the toolbars to show/hide. Whenever a mouse cursor is placed on any of the toolbar buttons, tool  
tips are highlighted. The toolbars are dockable except the power system element toolbar. 

Multi-layer technique is used for placing the drawing objects in different layers. Unlimited layers are 
supported by the package. A network can be edited in several different layers, so that the HV 
network for instance, is in one layer, and the MV network is in other layer. The user can edit the 
object layer after placement. The user can replace the power system analysis results on to a 
particular layer only. The user has the option to view only the selected layer objects. The objects 
belonging to other layer are hidden from the user. This facilitates the user to take print / plot of the 
layer wise diagram with / without results. 

The drawing object can be selected by clicking a left mouse button (LMB) on it. The selected object 
will be redrawn with a tracker surrounding the object. The user can perform an edit or delete or  
move operation on the selected objects. The editing operations are like changing the line styles, line 
colour, fill styles, fill colour, text font, text colour, etc. 

To invoke Power System Network Editor, Double click on the icon to left of the Power System 
Network Editor on the MiP-PSCT main screen. 

1.1 File Menu 
 

File Menu offers the following options 
 
1.1.1 Creating a New document 

 
Use “File−>New” to create a new document in Power System Network Editor. Select the type of 
new file you want to create in the File New dialog box. If the file extension is not provided, a default 
extension of “gui” is assumed. 

Shortcuts 

Keys: CTRL+N  Toolbar:       

1.1.2 Close Document 
 

Use “File−>Close” to close all windows currently opened in the active document. Make sure to save, 
as if you close a document without saving, you lose all changes made since the last time you saved 
it. Before closing an untitled document, Power System Network Editor displays the Save As dialog 
box and suggests that you name and save the document. You can also close a document by using 
the Close icon on the document's window. 

1.1.3 File Open Command 
 

Use “File−>Open” menu option to open an existing gui document in a new window. More than one 
document can be opened at a time. Use the Window menu to switch among the multiple open 
documents. 

Shortcuts 

Keys: CTRL+O  Toolbar:       

 
1.1.4 Save Document 

 
Use “File−>Save” to save the active document to its current name and directory. When you save a 
document for the first time, Power System Network Editor displays the Save As dialog box so as   to 
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name your document. If you want to change the name and directory of an existing documents  
before you save it, choose the Save As command. 

 
Shortcuts 

Keys: CTRL+S Toolbar:      

1.1.5 Save as Document 
 

Use “File−>Save as” to save and name the active document. Power System Network Editor 
displays the Save As dialog box to name your document. To save a document with its existing name 
and directory, use the Save command. 

1.1.6 Save as Image 
 

Use “File−>Save as Image” to save & name the active document as image. Power system Network 
Editor displays the Save Graph as an Image dialog box to name your document as bmp. 

Results of studies like Load flow, Short circuit etc. can be plotted on the diagram in network editor. 
These plots can be saved as image (*.bmp or *.jpg) by selecting the option File−>Save As Image 

1.1.7 Save Snapshot 
Once the diagram and the database are finalized, it may be required to do study for different cases 
and store the results for further analysis and for printing purposes. 

Power system network editor provides an option to store the diagram status and the results plotted 
as snap shots. A snap shot can be stored, loaded, deleted or modified. This will be extremely helpful 
during dynamic simulation wherein the change in status and circuits are not stored in the database 
(however, it can be saved explicitly by saving it as a new contingency). 

This facility avoids storing of data in the database. However, if the study for this case has to be done 
at a later stage then it has to be stored in the database. This snap shot can be used for storing the 
results. 

To store a snap shot: 

Select a contingency or dynamic simulation. 

Perform the load flow analysis by changing the status or number of circuits. 

Insert a text box to describe this case. The same text can be used for describing different cases. 

To store the results and status, select save snap  shot from File menu or select from       the   
toolbar. 

The following dialog box appears. 

Give the file name and description for this case. 

Click Ok to save the snap shot. 

Continue the dynamic simulation and the required results can be stored as snap shots. 

1.1.8 Load Snapshot 
 

To load the snap shot file select Load Snap shot from file menu or select from the toolbar. The 
following dialog box appears 
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Use “File−>Print Preview” to display the active document 
as it would appear when printed. When you choose this 
command, the main window will be replaced with a print 
preview window in which one or two pages will be 
displayed in their printed format. The print preview toolbar 
offers you with options to view either one or two pages at a 
time; move back and forth through the document; zoom in 
and out of pages; and initiate a print job. 

 

 
Click on – 

Load – to retrieve a stored snap shot. 

Delete – to delete the association of the selected snaps shot with this GUI and delete the 
corresponding snap shot file. 

Modify – to change the path or the description of selected snap shot. 

Browse – to select a different *. Snap file 

Cancel to stop the loading process. 

Double click on the selection to load the snap shot. The description of the current snap is displayed 
on the status bar. 

Note: 

Snapshots should be used after freezing the network configuration and when there are no more 
additions to the diagram. 

If network is modified, the snapshots should be created once again to reflect the modifications 
made. 

1.1.9 Import From Gut File 
 

The advantage of GUT file format is that the user can generate a MiGui diagram from the ASCII file. 
This option can be selected from the main menu File > Import from Gut file. 

1.1.10 Export to Gut File 
 

Open a “Gui” file in Network Editor. Then select the option from main menu File > Export to Gut 
File. This opens save as dialog box. Give the file name. The “*.Gut” file can be open in the notepad. 

1.1.11 Convert to AutoCAD 
 

Open a GUI and select the option File > Convert to AutoCAD which opens dialog box. Select the 
folder and type a file name which saves the file with .dxf extension. This new file can be opened in 
AutoCAD. All the elements will be converted to AutoCAD except the bmp present in the GUI file. 

1.1.12 Print 
 

Use “File−>Print” to print a document. This command presents a Print dialog box, where you may 
specify the range of pages to be printed, the number of copies, the destination printer, and other 
printer setup options. 

Shortcuts 

Keys: CTRL+P  Toolbar:      

1.1.13 Print Preview 
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1.1.14 Print Set up 
 

Use “File−>Print Set up” to select a printer and a printer connection. This command presents a 
Print Setup dialog box, where you specify the printer and its connection. 

1.1.15 Print Info 
 

Use “File−>Print Info” to set /remove the margin, border, header, footer, and single page, multiple 
page or custom view before printing.   Use Print Info for better printing results. 

The module supports printing and plotting of the drawings generated using Power System Network 
Editor. The module supports all the printer/plotter drivers installed in the system. The Print set-up 
dialog can be used to configure the printer and its settings. The properties are derived from the 
printer driver. The standard settings like paper size, paper orientations, printer scaling, quality of 
print, etc. can be configured. In addition to the standard settings, settings of margins, header and 
footer 

information can be provided using print info property pages. The user can specify the left, top, right 
and bottom margins of the paper size. If the printing is in parts, then the user can specify the 
overlapping area for each page along X and Y direction. 

The user can configure the style for the header and footer. The figure shows the header dialog  
page. The same properties hold good for the footer information also. The header consists of 3 text 
information which are used to display the information at left, centre and right of the margin. Each of 
the text can be Nothing / User specified text / Page number / Matrix Number / Date / Time. The user 
can configure the header line colour, thickness and style, header text font and header text colour. 
Similarly configuring can be done for footer 

also by selecting footer dialog page. Apart from printing of the whole document either in parts or on 
a single page, the user can specify the portion of the diagram in the form of a window. The control 
parameters for the window will be shown in figure. The selected window can be placed in centre 
along X or/and Y direction. The selected portion can also be made to fit the page size along X  
or/and Y direction. 

 
1.1.16 Exit 

 
Use File−>Exit to end your Power System Network Editor session. You can also use the Close 
command on the application Control menu. Power System Network Editor prompts you to save 
documents with unsaved changes. 

Shortcuts Mouse: Double-click the application's Control menu button. 

Keys: ALT+F4 

 

1.2 Edit Menu 
 

Edit menu offers the following options 
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1.2.1 Cut 
 

Use “Edit−>Cut” to remove the currently selected data from the document 
and put it on the clipboard.  This command is unavailable if there is no data 
currently selected. 

Cutting data to the clipboard replaces the contents previously stored there. 

Keys:        CTRL+X   Toolbar:      

1.2.2 Copy 
 

Use “Edit−>Copy” to copy the currently selected data of the document and 
put it on the clipboard. This command is unavailable if there is no data 
currently selected. 

 

Copying data to the clipboard replaces the contents previously stored there. 

1.2.3 Paste 
 

Use “Edit−>Paste” menu command to insert a copy of the clipboard 
contents at the insertion point. This command is unavailable if the clipboard is 
empty. 

Keys: CTRL+V  Toolbar:     

 
1.2.4 Paste with Connections 

 
Use “Edit−>Paste with connections” menu command to insert a copy of the 
clipboard contents at the insertion point with connections of power system 
elements. This command is unavailable if the clipboard is empty. 

1.2.5 Paste Special 
 

Use “Edit−>Paste Special” menu command to insert a copy of the clipboard 
contents at the insertion point with connections of power system elements with 
new identity. This command is unavailable if the clipboard is empty. 

1.2.6 Copy Font Library 
 

The option Edit−> Copy Font Library opens the dialog as shown below. Browse 
for the font library. Copy the font from Font’s library to gui font. 

Copy All: From font’s library all will copy to GUI font. 
 

Clear all: This option will clear the library To copy a single font from library-to-

GUI: 

Browse for the path from where the library has to be copied 

Keys: CTRL+C 
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. 
Select the font from the library by a single click and paste it to the GUI file 
click on the colour to change the font colour 

 

1.2.7 Userdef Font Property 
 

The option Edit->Font Property is used to change the colour and font ratio of the 
selected font on the GUI.  Double click on the colour to change the font colour 
 
 
 

 
 

1.2.8 Userdef Font Shape 
 

This option is selected to change the font shape. Any shape can be 
drawn with any colour 

Colour: Colour can be changed 

Clear All: clear the grid 

Fill All: Fills the complete grid 

Done: Double click will take the control to the Font Library where 
the font is stored. 

Prev<: Take the control to the previous font no. 

Next>: Take the control to the next font no. 

1.2.9 Undo 

Use this option to repeat the previous actions. You can use this button       from the tool bar. 

1.2.10 Redo 

Use this option when you did not want to undo an action.   You can use this button from the  
tool bar. 

1.2.11 Undelete 
 

Use “Edit−>Undelete” menu command to undelete the last element deleted. The Undelete 
command traces to previous delete one at a time. 

Keys: CTRL+U 

1.2.12 Delete 
 

Use “Edit−>Delete” to remove the selected object(s) from the document. When an object is 
selected, tracker is drawn around the drawing object. Select delete option from the menu item 

Edit−>Delete or  from a toolbar button. 

 
1.2.13 Line and Fill Style 
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Use “Edit−>Line and Fill Style” or from the toolbar to edit the line and fill styles used to draw 
objects. The newly selected line/fill styles and colour can be previewed inside a preview box. The 
line and fill properties that are editable are - 

Line style can be set to NULL for not showing a line around the object. 

Line style can be set to other styles by clicking a mouse on the choice. The styles are valid only for a 
one point thickness. 

Line thickness can be set from 1 to 50. The line thickness more than 1 is effective only for a solid  
line style. 

Line color can be set to any of the RGB mixture value. 

Fill style can be set to NULL for not filling the enclosed region. 

Fill style can be set to other styles by clicking a mouse on the choice. 

Fill color can be set to any of the RGB mixture value. 

1.2.14 Text Font 
 

Use “Edit−>Text Font” to change the text font used to write the text inside a textbox. The same 
option can be selected through a context menu item Text Font. Add the textboxes whose text 
font are to be changed in to the selection list. Then select the text font. A general text font 
selection dialog box is shown to the user. Choose the options for text style, size, colour, etc... 
and select OK to accept the new font, CANCEL to ignore the selection. All the selected text 
boxes are redrawn with new text font, if OK is selected. 

 

1.2.15 Text Alignment 
 

Use “Edit−>Text Alignment” to change the textbox alignment to either left-right-centre of the 
bounding rectangle. The same option can be selected through a context menu item Text 
Alignment 

1.2.16 Replace Text 
 

Use “Edit−>Replace Text” to search and replace text. The 

features are Replacement can be done only in a particular layer or 

in all the layers Object string or display string 

Move to the first 

occurrence Move to the 

last occurrence Find 

Next 

Replace/ 

Replace all 

Match case 

Match whole words 
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This option can be used to globally select any object in 
GUI. 

This opens a dialog box to modify the selected object’s 
properties. Select object form the list box. Then click on 

Select:  This selects objects in the single line diagram 

Height: Edit object’s height in pixels 

Width: Edit object’s width in pixels. 

1.2.17 Select 
Use “Edit−>Select” to select object(s) within a document to perform 

operations like Changing object(s) line and fill styles 

Move object(s) to new 

location Delete object(s) from 

a document 

Resizing of object (applicable during only one 
Object selection) 

When an object is selected, tracker is 
highlighted around the selected drawing 
object. To select one object at a time, click 
mouse LMB on desired object. The previously 
selected object is  deselected and a new 
object, which is intersected with the mouse 
click point, is selected. If the mouse click 
position is not on any of the objects, the 
selection list is cleared. 

Objects can be selected in different ways like all objects, only view objects and layer-wise. 

To make Multiple Object(s) selection, draw a tracker rectangle around the objects. The objects, 
which are intersected with the tracker rectangle, are selected and a tracker is shown around 
each of the selected objects. This can be done by holding SHIFT key and single clicking on the 
objects which are to be grouped. To deselect double click on the object holding the SHIFT key. 

1.2.18 Select Objects 
 

 
 
 
 
 
 
 
 
 

Resize: Selected object’s height and width will be 
modified. 

 
1.2.19 Object Alignment 

 
Use “Edit−>Object Alignment” to change the object alignment to either left-right-top-bottom- 
horizontal-vertical. The option can be selected either from a menu item Edit−>Object Alignment−>. 
The same option can be selected through a context menu item Edit−>Object Alignment. 

Add the objects which are to be aligned in to the 
selection list, and then select the alignment  
choice; the objects are redrawn at new aligned 
location. The reference for the justification is  
taken as the object with largest size. The object 
can be aligned to either 

Left - All objects left position is made equal to the 
largest object left. 

Right - All object right position is made equal to 
the largest object right. 

Top - All objects top position is made equal to the 
largest object top. 

Bottom - All objects bottom position is made equal to the largest object bottom. 

Horizontal - All objects centre is made equal to the largest object centre along Y axis. 

Vertical - All objects centre is made equal to the largest object centre along X axis. 

Equalise - All objects size is made equal to the largest object size. 
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1.2.20 Text Blink Flag 

 
Use “Edit−>Text Blink Flag−>” to provide a  blinking effect. 
Add the textboxes whose blink flag are to be changed in to  
the selection list, and then select the text blink flag, All the 
selected text boxes are redrawn with new text blinking effect 

 
1.2.21 Insert New Object 

 
Use this option to insert a new object into the document 

Create New: Inserts a selected object type into the document 

Display as icon: Inserted object will be displayed as an icon 

Create from File: Browse for the file which is to be inserted. 

 

The contents of the file is inserted as an object into the document so that you may activate it using 
the program which may create it 

 

1.2.22 Link 
 

The picture will be linked to the file so that changes to the file will be reflected in the document. 
 

 

1.2.23 Restore 
 

Use “Edit−>Restore” to restore the deleted Power System Elements in the Power system Network 
Editor. The deleted elements will be dumped into Dumpster (which is analogous to “Recycle Bin” in 
windows).  This option is used to restore the selected elements from Dumpster. 

1.2.24 Empty Trash 
 

Use “Edit−>Empty Trash” to Clear or Empty the Contents of the Dumpster (recycle bin). All 
the deleted elements of the Power System Network Editor will be in the recycle bin 

1.2.25 Group 
 

Use “Edit−>Group” to group the selected objects. Select the objects you want by holding down 
shift as you click each object. 

1.2.26 Ungroup 
 

Use “Edit−>Ungroup” to ungroup the grouped objects. 

1.2.27 Line Status 
 

Use “Edit−>Line Status” option to open or close the lines which are drawn from Draw Tool 

Box. Line Status has following opening options for lines 

Open 

Close 

From end open 

To end open 

1.2.28 Library 
 

This option can be selected from the main menu Edit -> Library or select the power system  
element (by holding Ctrl key and single click of Left Mouse Button) and right click will open the 
popup,  in that select Library option . This opens the element library form. 
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1.2.29 Attribute Location 
 

This option can be selected from the main menu Edit -> Attribute 
Location. Length and line Type attributes can be moved or 
relocated with this option. 

To move the attribute of the particular element, select the element 
on GUI and then select Edit > Attribute Location > Length/Line 
Type. If length is selected on click of mouse on GUI length of the 
line will be moved. 

 

1.3 View Menu 
 

The View Menu offers the following options: 

1.3.1 Tool Bar 
 

Use “View−>Toolbar” to show or hide the general-purpose toolbar. This option will be either 
ON/OFF. If this option is ON, the toolbar is shown at the top by default else the toolbar is hidden. 

 

The toolbar is dockable, i.e., it can be placed at any location on the screen. The commands 
interfaced to the buttons placed on the toolbar from left to right order are – 

 

 
New Open a new document 
Open Open an existing document 
Save Save a current document 
Cut Remove the object from document and place it in a clip board 
Copy Copy the contents of selection to clipboard 
Paste Paste the clipboard contents at user specified location 
Print Print the current document 
Undo Repeat the last action 
Redo Redo operation 
Set Brush Set / Modify the line and brush styles to be used for drawing 

objects 
Rotate Rotate the selected object by 90 degrees 
Delete Delete the object from the document 
Grid Lines Show / Hide  the horizontal and vertical grid lines 
Real Time Zooming Set the document zoom factor in real time 
Orthogonal Mode Set Ortho mode to draw the lines only horizontal / vertical. 
Display Code Control option to place a power system display code 
Object Intersection Toggle for selecting the objects, 0 – Enclose, 1 – Intersection. 
PS (End with Bus / 
Without Bus) 

If ON drawing ends with connection on the bus, if OFF drawing 
ends without connection on the bus 

Locate a Bus Search for a bus by its number or name 
Find & Replace Finds and replaces the specified text 
Save snapshot Stores the diagram status and results 
Load snapshot Opens the stored snapshot file 
About Shows the about dialog box 
Context Sensitive Help Selection for Context sensitive help 
Energy connectivity Select to View Energy Connectivity 
Trash Toggle the view between the trash and the document 
Attributes ON/OFF the Attributes shown on the SLD for lines and 

transformers 
Set Active 
Contingency Schedule 

Opens current Schedule and contingency dialog 

Set Auto Save Option Opens the Auto save option dialog 
Full Screen View of full screen by switching off the tool bars 
View Element Property On and off of element Property window 
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1.3.2 Drawing Toolbar 
 

Use “View−>Drawing Toolbar” to show or hide the basic drawing toolbar. This option will be either 
ON/OFF. If this option is ON, the toolbar is shown at left by default. Else the toolbar is hidden. This 
toolbar is dockable, i.e., it can be placed at any location on the screen. The commands interfaced to 
the buttons placed on the toolbar from top to bottom order are: - 

Object Selection 

Line 

Rectangle  

Round Rectangle 

Square 

Diamond 

Ellipse 

Circle 

Arc 

Chord 

Pie 

Semi-Circle 

Sine Wave 

Polyline 

Polygon 

Place a textbox 

User Define Object 

Formula 

1.3.3 Power System Element Toolbar 
 

Use “View−>Power System Element Toolbar” to show or hide the power system elements 
toolbar. This option will be either ON/OFF. If this option is ON, the toolbar is shown at right by 
default. Else the toolbar is hidden. The toolbar is non-dockable i.e., it can’t be moved. The 
commands interfaced to the buttons placed on the toolbar from left to right order are – 

SHUNT 

Bus 

Generator 

Utility 

Wind Generator 

Motor 

Load  

Cyclic Load 

Shunt Reactor 

Shunt Capacitor 

Solar PV Plant 

SERIES 

Transmission Line 

2Winding Transformer 

3Winding Transformer 

4Winding Transformer 

Series  Resistor 
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Series Reactor 

Series Capacitor 

Bus Coupler – Open 

Bus Coupler – Closed 

ETA 

Inst. Current Source 

Impulse Current Source 

RMS Current Source 

Inst. Voltage Source 

Impulse Voltage Source 

RMS Voltage Source 

Lightning Arrester 

Delta Connected Load 

Arc Fault 

Vacuum CB Closed 
 

Metal Oxide Varistor 

Spark Gap 

Shunt Resistor 

HVDC 

HVDC Rectifier 

HVDC Inverter 

DC Link 

Filter 

FACTS 

Shunt Fact Device 

Static VAR Comp 

Unified Power Flow Controller 

Thyristor Controlled Series Capacitor 

Static Phase Shifter 

PROTECTION 

Current Transformer 

Potential Transformer 

CVT 

Relay 

Fuse 

Voltmeter 

Ammeter 

Multimeter 

Measurement Data 

SYMBOL 

Star 

Star-Grounded 

Delta 

Ground 

Neutral Grounding Resistor 
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Isolator – Open 

Isolator – Closed 

Breaker – Open 

Breaker – Closed 

LV Breaker 

Four Winding Transformer 

Dynamic Link 

Bounded Text 

Battery 

Power System Block 
 
 
1.3.4 Object Dialog Bar 

 
Use “View−>Object Dialog Bar” option to show or hide the object property dialog bar. The option 
will be either ON/OFF. If the option is ON the dialog bar is shown at the bottom by default else the  

dialog bar is hidden. The dialog bar is dockable, i.e., it can be placed at any location on the screen. 
The contents of the dialog bar will be visible only when the object selection list is not empty. The 
dialog bar has 3 panes. The object information shown at different panes are - 

First pane - Object ID given by the program, it indicates the serial number of the object count placed 
in the document. The long integer value maintained should be unique in a document. 

Second pane - The layer name at which the object is placed is displayed. 

Third pane - Currently selected object Width and Height in Pixels. 

 
1.3.5 Contingency- Schedule Dialog bar. 

 

The option is used to show or hide the Contingency-Schedule Dialog bar. The option will be either 
ON/OFF. If the option is ON the status bar is shown at the bottom by default else the Contingency- 
Schedule Dialog bar is hidden. This dialog bar is non-dockable, i.e., it can’t be moved. 

1.3.6 Layer Control Toolbar 
 

Use “View−>Layer Control Toolbar” to show or hide the status bar. This option will be either 
ON/OFF. If the option is ON, the layer control bar is shown at the top by default. Else the layer 
control bar is hidden. The status bar is non-dockable, i.e., it can’t be moved. 

 

 
 

Set/Change layer: Selected objects can be changed to another layer. 

Layer control: On selection of this button opens the layer control 
panel which is as shown below. Selected layers can be ON/OFF, 
locked/Unlocked 

Add layer: On selection of this button adds one more layer to the 
layer control panel 

Delete Layer: Deletes the selected layer from the layer control panel 

Select: Selection of objects can be done from the selected drop down 
list. 
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1.3.7 Name Plate 
 

Use “View−>Name Plate” to insert a nameplate of standard 

format Requirements to use this option are: 

Make sure your document size is fixed. 

Create a text file in the following format: 

Line 1: Logo path 

Line 2: Company name Line1 

Line 3: Company name Line2 

Line 4: Job number 

Line 5: Drawing Number 

After selecting this option “Nameplate”, Power System Network Editor automatically inserts 
borderlines and few default texts (like Description, Approved, Reviewed, Job No, and Dwg. No, Rev, 
Date etc.) and then “File Open” dialog box appears in which you have to select the text file in which 
you have specified above lines of data. After selecting the text file, program inserts the text other 
than the Logo path. It inserts Logo into the document if Logo is found at specified path. If the Logo is 

not found at the specified path, a message is popped-up reporting to check the path and the Logo is 
not inserted.  All the data read from text files are placed in Layer14. 

 
 
1.3.8 Status Bar 

 
Use “View−>Status bar” to show or hide the status bar. This option will be either ON/OFF. If the 
option is ON, the status bar is shown at the bottom by default. Else the status bar is hidden. The 
status bar is non-dockable, i.e., it can’t be moved. The status bar has 6 panes. The information 
shown at different panes are - 

First pane - Menu options/toolbar status and other status information. 

Second pane - Current document, scale factor. By default it is 1.0 i.e., 1: 1 zoom. 

Third pane - Mouse cursor X and Y position on screen in pixels. 

Fourth pane - Current rotation angle in degree, when object selection list is empty. If the object is 
selected, selected object angle is displayed. 

Fifth pane - If Orthogonal mode is On, Ortho is displayed. Else blank is displayed. 

Sixth pane - If Caps lock is On, Cap is displayed. Else blank is displayed. 

1.3.9 Layer Control Panel 
 

Use “View−>Layer” to view object(s) within a document which  
are all user specified layer(s). By default all the layer view flags 
are set to ON, so that all objects present in different layers can be 
viewed simultaneously. To hide the objects present in a particular 
layer, turn off the view flag for a particular layer. 

For example to hide the objects in General layer. 

Select the menu option View−>Layer−>General to deactivate the 
view flag for the General layer. The objects present in the General 
layer are not drawn during next paint message. 

 
 
1.3.10 Grid Lines 

Use    “View−>Grid    Lines”    or     toolbar to show the grid lines along X and Y direction and X 
axis and Y axis centre lines. The grid lines are available only for view and not for printing. The flag 
can be turned ON/OFF. Turn ON the Flag to view the grid lines. The distance between grid lines 
along X and Y directions can be set independently. The grid line can be shown either with a dot line 
/ dash line style and colour can be set using the menu option Set−>Gridlines. 
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1.3.11 Display Code 
 

When the user views the power system analysis results for a particular case, the display code 
(ZZLPXX-XX.) is replaced by a numerical value of the analysis results. Use “View−>Display Code” 
to view back the code text of each of the display codes present in the system. Once this option is 
selected all the numerical values are replaced with display code text. 

1.3.12 Zoom Document to Fit 
 

Select “View−>Zoom Document to Fit” to view the complete diagram on a single page 
 
 
1.3.13 Text Blink Effect 

 
Select “View−>Text Blink Effect” to view the blinking effect for the textbox whose mode is set for 
blinking. The textboxes which are set for blinking mode starts blinking at the frequency depending   
on the time set for the timer through  Set−>Text blink Rate. 

 
 

1.3.14 Properties 
 

Use “View −> Properties” to find and 
select an element in the single line 
diagram 

A dialog box as shown below appears 

From the list box, select the  element 
and click OK. The element is located 
and selected. 

 
 
 
 

1.3.15 Layer Control Panel 
 

Select “View−> Layer Control Panel” which opens the layer control panel Selected layers can be 
ON/OFF. For details refer Layer Control Tool Bar. 

 
 
1.3.16 Display Options 

 
Voltage levels can be ON/OFF by checking display check 
box. 

OK: Saves the changes and displayed on the document. 

Cancel: Ignores the changes to display options 

Select All: Selects all the base voltages and all buses 
displayed on the document. 

De Select All: De selects all the base voltages and buses 
will not be displayed on the document. 

 
 
1.3.17 Simulation Report (LFA) 

 
Select “View−>Simulation Report (LFA)” to see the load flow results during dynamic simulation of 
load flow analysis. 

1.3.18 Energy Connectivity 
 

Select “View−>Energy Connectivity” to check Continuity of the Single Line Diagram. The parts 
connected and De-Energized appear in different colours. 
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1.3.19 Trash 
Select “View−>Trash” to check the contents of dumpster (recycle bin). All the deleted elements of 
power system network editor will be in trash. 

1.3.20 ZZ Code Form 
 

This option is used to View the display code associated with any power system 
element or other general drawing tools with which a power system elements 
associated. 

The display code will be displayed in a form and the code can be placed on  
the GUI by clicking on the corresponding code and placing it on the GUI. 

 
 
1.3.21 Attributes 

 
This option can be selected from the main menu View > Attributes. On selection of this, Length and 
Line Type will be displayed on the single line diagram if the GUI is connected with the database. 

 
 

1.3.22 Full Screen 
 

Select “View−> Full Screen” With this option SLD is viewed in full screen with more drawing area. 
Tool bars will disappear. 

This option can be selected from the tool bar          “Full Screen” 

1.3.23 Element Property 
 

Select “View−> Element Property” This option can be selected 
from   toolbar   View  element   property.   For   the database 

  connected GUI or network by default this option is  enabled. 
Click on Power system element will show the element property 
window. User can place this window on any part of the screen. 

1.4 Draw Menu 
 

Draw menu offers the following options: 

1.4.1 Selection 
 

If this selection mode is ON, then user can carry out operations like move, resize cut, copy and 
paste etc. If this selection mode is OFF, then user can carry out operations like panning, zooming 
and  to note the details of an object (in which layer it is, thickness etc.) 

1.4.2 Slant Line 

Use   “Draw−>Horz/Vert   Line”    OR     from a Draw toolbar on the LHS of the screen. This 
option is used to draw a line between start points to end point and to fit inside a rectangle formed by 
start point and end point. The line can be resized by dragging the handle on the rectangle box. The 
handles are highlighted whenever an object is selected for resizing or moving. If the Orthogonal flag 
is ON, the line will be drawn in Horizontal / Vertical fashions only. Turn OFF the Orthogonal flag to 
draw a line at any desired angle. 

Procedure: 

Set the object layer from the menu item Set−>Object Layer to which line is to be 

placed. Set the orthogonal mode On/Off 

Select the Option from a menu item Draw−>Line or from a 

Toolbar Place the cursor at desired location, click mouse LMB 

Holding down the mouse LMB move the cursor to new location. As the cursor is dragged, the line is 
redrawn from selected starting point to end point as a preview of line. 

Release the mouse LMB to accept line. 

Use the resize handles shown outside for resizing 
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1.4.3 Rectangle 

Use “Draw−>Rectangle” OR     from the Draw toolbar on the LHS of the screen. This option is 
used to draw a rectangle between start points to end point and to fit inside a rectangle formed by 
start point and end point. The rectangle can be resized by dragging a handle on the rectangle box. 
The handles are highlighted whenever an object is selected for resizing or moving. Procedure is 
similar to slant line drawing. 

 

1.4.4 Round Rectangle 

Use  “Draw−>Round  Rectangle”   OR     from the Draw toolbar on the  LHS  of  the  screen. 
This option is used to draw a round rectangle between start point to end point and to fit inside a 
rectangle formed by start point and end point. The round rectangle can be resized by dragging a 
handle on the rectangle box. The handles are highlighted whenever an object is selected for resizing 
or moving. Procedure is similar to slant line drawing. 

 
 

1.4.5 Square 
 

Use “Draw−>Square” OR     from the Draw toolbar on the LHS of the screen.    This 
option is   used   to   draw  a  square between start point to end point and to fit inside a 
rectangle 
formed by start point and end point. The square can be resized by dragging a handle on the 
rectangle box. The handles are highlighted whenever an object is selected for resizing or moving. 

1.4.6 Diamond 
 

Use   “Draw−>Diamond”   OR from  Draw toolbar  on the  LHS  of  the screen.  The option 
is used to draw a diamond between start point to end point and to fit inside a rectangle formed by 
start point and end point. The diamond can be resized by dragging a handle on the rectangle box. 
The handles are highlighted whenever an object is selected for resizing or moving. Procedure is 
similar  to slant line drawing. 

1.4.7 Text Box 

Use “Draw−>Text Box” OR   from Draw toolbar on the LHS of the 
screen. This option is used to place a textbox at a user-selected point. 
The textbox will be resized automatically as the user inserts a 
character into the textbox string. The handles are highlighted 
whenever an object is selected for resizing or moving. The text is 
aligned to the vertical centre with respect to the textbox rectangle. To 
modify the  textbox string, select only one textbox for modification, use 
backspace key to delete the last character from a string. 

Procedure: 

Set the object layer from a menu item Set−>Object Layer to which textbox has to be 

placed. Select the Option from a menu item Draw−>Text Box or from a Toolbar 

Indicate the textbox location by clicking mouse LMB 

Key in the character string to display inside the 

textbox Use Backspace key to modify/delete the 

character. 

Click mouse RMB to cancel the option. 

Use the resize handles shown outside for 

resizing Text Box Alignment 

The textbox can be aligned with respect to its border, the alignment facilities 

are Left - selected textbox rectangle left positions are made same 

Right - selected textbox rectangle right positions are made same 

Top - selected textbox rectangle top positions are made same 

Bottom - selected textbox rectangle bottom positions are made 
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same 

Horizontal - selected textbox rectangles are justified horizontally with respect to 

center Vertical - selected textbox rectangles are justified vertically with respect to 

center Equalise - all textbox rectangles are made equal to the first object 

1.4.8 Ellipse 

Use “Draw−>Ellipse” OR   from Draw toolbar on the LHS of the screen. This option is used to 
draw an ellipse from start point to end point and to fit inside a rectangle formed by  start 
point and end point. The ellipse can be resized by dragging a handle on the rectangle box. The 
handles are highlighted whenever an object is selected for resizing or moving. Procedure is similar 
to slant line drawing. 

1.4.9 Circle 

Use  “Draw−>Circle”  OR   from Draw toolbar on the LHS of the screen. This option is used 
to draw a circle from start point to end point and to fit inside a rectangle formed by start point and 
end point.  The  circle  can  be  resized  by dragging a  handle  on  the  rectangle  box.  The  
handles are highlighted whenever an object is selected for resizing or moving. Procedure is similar 
to slant line drawing. 

1.4.10 Arc 
 

Use “Draw−>Arc” OR from Draw toolbar on the LHS of the screen. The option is used to 
draw an arc from start point to end point and to fit inside a rectangle formed by start point and end 
point. The arc can be resized by dragging a handle on the rectangle box. The handles are 
highlighted whenever an object is selected for resizing or moving. Procedure is similar to slant line 
drawing. 

1.4.11 Chord 
 

Use  “Draw−>Chord”  OR from Draw toolbar on the LHS of the screen. This option is used to 
draw a chord from start point to end point and to fit inside a rectangle formed by start point and end 
point. The chord can be resized by dragging a handle on the rectangle box. The handles are 
highlighted whenever an object is selected for resizing or moving. Procedure is similar to slant line 
drawing. 

1.4.12 Pie 
 

Use   “Draw−>Pie”   OR from Draw toolbar on the LHS of the screen. This option is used to 
draw a pie from start point to end point and to fit inside a rectangle formed by start point and end 
point. The pie can be resized by dragging a handle on the rectangle box. The handles are 
highlighted whenever an object is selected for resizing or moving. Procedure is similar to slant line 
drawing. 

1.4.13 Semicircle 

Use   “Draw−>Semicircle”   OR   from Draw toolbar on the LHS of the screen. This option is 
used to draw a semi-circle from start point to end point and to fit inside a rectangle formed by start 
point and end point. The semi-circle can be resized by dragging a handle on the rectangle box. The 
handles are highlighted whenever an object is selected for resizing or moving. Procedure is similar  
to slant line drawing. 

1.4.14 Sine Wave 
 

Use    “Draw−>Sine    wave” OR from Draw toolbar on the LHS of the screen. This   option is 
used to draw a sine wave from start point to end point and to fit inside a rectangle formed by start 
point and end point. The sine wave can be resized by dragging a handle on the rectangle box. The 
handles are highlighted whenever an object is selected for resizing or moving. Procedure is similar  
to slant line drawing. 

1.4.15 Polyline 

Use  “Draw−>Polyline”  OR   from Draw toolbar on the LHS of the screen. To draw a Polyline 
from start point to intermediate points till endpoint and to fit inside a rectangle formed by a polygon 
points. The Polyline can be resized by dragging a handle placed along the polygon points. The 
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handles are highlighted whenever an object is selected for resizing or moving.  If the Orthogonal   
flag is ON, polygon will be drawn with straight lines. Orthogonal flag is OFF to draw a Polyline with 
inclined lines. With Orthogonal mode ON, when a point is touched to move, the cursor shape is 
changed to plus and the touched point is aligned  in X  or Y  direction  with  respect  to  previous 
point depending on whether the distance along  X or Y direction is more. Procedure is similar to  
slant line drawing. 

 

1.4.16 Polygon 

Use  “Draw−>Polygon”  OR   from Draw toolbar on the LHS of the screen. This option is used 
to draw a polygon from start point to intermediate points till end point and to fit inside a rectangle 
formed by polygon points. The polygon can be resized by dragging a handle placed along the 
polygon points. The handles are highlighted whenever an object is selected for resizing or moving. If 
the Orthogonal flag is ON, polygon will be drawn with straight lines (Horizontal / Vertical lines only). 
Orthogonal flag is OFF to draw a polygon with inclined lines. With Orthogonal mode ON, when a 
point is touched to move, the cursor shape is changed to plus and the touched point is aligned in   X 

or Y direction with respect to previous point depending on whether the distance along X or Y 
direction is more. 

Procedure: 

Set the object layer from a menu item Set−>Object Layer to which polygon has to be 

placed. Set the orthogonal mode On/Off 

Select the Option from a menu item Draw−>Polygon or from a Toolbar 

Place the cursor at desired location, click mouse LMB 

Move the cursor to new location. As the cursor is dragged, a line is redrawn from start point to new 
point as a preview of polygon. 

Click mouse LMB to accept a point for polygon. 

Double click mouse LMB to complete the polygon. 

Click mouse RMB to erase the incomplete polygon. 

Use the resize handles shown outside for resizing 

1.4.17 User Def Font 
 

On selection of this, opens the font Library form as shown below 
Double click on any one cell which opens 16x16 grid in which user 
can draw any shape as shown in the figure, which will be saved in 
the font library. 

For Details Refer Section 2.2.8 User Def Font shape 

1.4.18 Formula 
 

This option is used to do mathematical operations like, addition, subtraction, multiplication, division 
of two or more zzcodes. When plotting load flow analysis these are replaced by its equivalent 
values. The mathematical formulas supported are 

add 

subtract 

multiply 

divide 

sin 

cos 

tan 

asin 

acos 

atan 

exp 

pow 
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ln 

log 

sort 

1.5 Elements Menu 
 

Elements menu offers following options 

SHUNT 
 

 
Shunt Elements 

• Bus 

• Generator 

• Utility 

• Wind Generator 

• Motor 

• Load 

• Cyclic Load 

• Shunt Reactor 

• Shunt Capacitor 

• Solar PV Plant 
 
 

Drawing – Select a shunt element and double click on the selected bus. If the  element  is 
connected, the display code appears. 

Rotation - Select an object, click the rotate button. Object is rotated in the steps of 90 degrees. The 
point connected with a bus is not disturbed during rotation. 

Resizing - Use the two points shown around for resizing. Increase the distance between the two 
points to inflate object symbol OR decrease the distance between two points to deflate object 
symbol. 

Moving - If the orthogonal mode is ON, object can be moved along X or Y direction only. Turn OFF 
Orthogonal Mode to move in any direction. If the bus is placed vertical and the object is placed 
horizontal, the object can be moved along and up to the bus top/bottom with Ortho ON. If the bus is 
placed horizontal and the object is placed vertical, the object can be moved along and up to the bus 
left/right with Ortho ON. If the Ortho is OFF, the object can be placed at any location, the connecting 
line to the bus is inclined. 

Place - If the user tries to place a Shunt element not on a bus, an error message is popped up and 
the shunt element is not accepted 

Resize - The Shunt element can be resized at any time by dragging the handle. 
 
 
1.5.1 Bus 

 
Use “Elements−>Shunt Elements->Bus” OR from Power System toolbar on the RHS of the 
screen. This option is used to draw a bus between start point to end point. The bus is drawn either 
horizontal or vertical depending on the difference between the down point and mouse point is moved 
along X or Y direction. The bus can be resized at any time by dragging a handle shown on the two 
ends of a bus. The handles are highlighted whenever an object is selected for resizing or moving. To 
select a bus, click mouse LMB on it. If the Orthogonal flag is ON, the bus can be moved along X or  
Y direction only, Orthogonal flag is OFF to move in any direction. 
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Procedure: 

Set the object layer from a menu item Set−>Object Layer to where bus has to be 

placed. Click on the bus icon. Voltage selection tool bar appears. 

Select the voltage level for bus. 

Place the cursor at desired location, click mouse LMB. 

Holding down the mouse LMB move the cursor to new location. As the cursor is dragged, the bus is 
redrawn from down point to new point as a preview of bus. 

Release the mouse LMB to accept bus. 
 

Use the resize handles shown outside for resizing 

Note: 

When a bus is selected for moving the power system elements connections to a bus are also 
selected for moving. 

To select a Bus alone, click mouse LMB on a bus by holding down CTRL key. 

1.5.2 Generator 
 

Use “Elements−>Shunt Elements−>Generator” OR from Power System toolbar on the RHS 
of the screen to draw a generator. The handles are highlighted whenever an object is selected for 
resizing or moving. To select a generator, click mouse LMB on it. If the display code flag is ON, the 
code to show generator real and reactive power flows are placed in line with the generator. Place 
the code by moving it to the desired location if required. If the user tries to place a generator other 
than on a bus, an error message is popped up and generator connection is not accepted. 

1.5.3 Utility 

Use   “Elements   −>Shunt   Elements−>Utility”   OR       from Power System toolbar on  the 
RHS of the screen to draw a Utility. The handles are highlighted whenever an object is selected for 
resizing or moving. To select a Utility, click mouse LMB on it. If the display code flag is ON, the code 
to show Utility real and reactive power flows are placed in line with Utility. Place the code by moving 
it to the desired location if required. If the user tries to place a Utility other than on a bus, an error 
message is popped up and Utility connection is not accepted. 

1.5.4 Wind Generator 
 

Use    “Elements    −>Shunt    Elements−>Wind  Generator”   OR from   Power   System 
toolbar on the RHS of the screen to draw a wind generator. The handles are highlighted whenever 
an object is selected for resizing or moving. To select a wind generator, click mouse LMB on it. If the 
display code flag is ON, the code to show wind generator real and reactive power flows are placed  
in line with the wind generator. Place the code by moving it to the desired location if required. If the 
user tries to place a wind generator other than on a bus, an error message is popped up and wind 
generator connection is not accepted. 

 
 
1.5.5 Motor 

 
Use   “Elements  −>Shunt   Elements−>   Motor”       OR from Power System toolbar on the RHS  
of the screen to draw an Induction motor. The handles are highlighted whenever an object is 
selected for resizing or moving. To select a motor, click mouse LMB on it. If the display code flag is 
ON, the code to show motor real and reactive power flows are placed in line with the motor. Place 
the code by moving it to the desired location if required. If the user tries to place a motor other than 
on a bus, an error message is popped up and motor connection is not accepted. 

1.5.6 Load 

Use  “Elements  −>Shunt  Elements−>  Load”  OR   from Power System toolbar on the RHS of 
the screen to draw a load. The handles are highlighted whenever an object is selected for resizing or 
moving. To select a load, click mouse LMB on it. If the display code flag is ON, the codes to show 
load real and reactive power flows are placed in line with the load. Place the code by moving it to the 
desired location if required. If the user tries to place a load other than on a bus, an error message is 
popped up and load connection is not accepted. 
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1.5.7 Cyclic Load 

Use  “Elements  −>Shunt  Elements−>Cyclic  Load”  OR   from Power System toolbar on the 
RHS of the screen to draw a cyclic load. The handles are highlighted whenever an object is selected 
for resizing or moving. To select a cyclic load, click mouse LMB on it. If the display code flag is ON, 
the code to show cyclic load real and reactive power flows are placed in line with the cyclic load. 
Place the code by moving it to the desired location if required. If the user tries to place a cyclic load 
other than on a bus, an error message is popped up and cyclic load connection is not accepted. 

 
 

1.5.8 Shunt Reactor 

Use “Elements −>Shunt Elements−>Shunt Reactor” OR from   Power  System  toolbar  on  
the RHS of the screen to draw a shunt reactor. The handles are highlighted   whenever   the 
object is selected for resizing or moving. To select a reactor, click mouse LMB on it. If the display 
code flag is ON, the code to show reactor real and reactive power flows are placed in line with the 
reactor. Place the code by moving it to the desired location if required. If the user tries to place a 
reactor other than on a bus, an error message is popped up and reactor connection is not accepted. 

1.5.9 Shunt Capacitor 
 

Use  “Elements −>Shunt  Elements−>Shunt Capacitor” OR from  Power  System toolbar on 
the RHS of the screen to draw a shunt capacitor. The handles are highlighted whenever the object is 
selected for resizing or moving. To select a capacitor, click mouse LMB on it. If the display code flag 
is ON, the code to show capacitor real and reactive power flows are placed in line with the capacitor. 
Place the code by moving it to the desired location if required. If the user tries to place a capacitor 
other than on a bus, an error message is popped up and capacitor connection is not accepted. 

 
 
1.5.10 Solar PV 

Use  “Elements  −>Shunt  Elements−>Solar  PV”  OR      from Power System toolbar on the 
RHS of the screen to draw a solar PV generator. The handles are highlighted whenever an object is 
selected for resizing or moving. To select a wind generator, click mouse LMB on it. If the display 
code flag is ON, the code to show wind generator real and reactive power flows are placed in line 
with the solar PV generator. Place the code by moving it to the desired location if required. If the 
user tries to place a solar PV generator other than on a bus, an error message is popped up and 
solar PV generator connection is not accepted. 

SERIES 

Series Elements 

• Transmission Line 

• Two winding Transformer 

• Three winding Transformer 

• Series Resistor 

• Series Reactor 

• Series Capacitor 

• Bus Coupler - Open 

• Bus Coupler - Closed 
 
 

Drawing – Drop the series element in-between the buses. Automatically a connecting line starts 
following the mouse pointer. Move the mouse on to a bus and double click to connect From side 
connection. Another connecting line automatically starts towards the To side connection. Drag the 
mouse towards the TO side connection and double click on the bus to establish the TO side 
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connection. If connection is accepted, the Display Code appears. Keeping the orthogonal mode  
ON, connecting line segments can be drawn either horizontal or vertical only. Orthogonal mode is 
OFF to draw a connecting line inclined at any angle. 

Rotation – Select the object and click the rotate button. Object is rotated in steps of 90 degrees. 
Connecting points to bus remain same. 

Moving - If the orthogonal mode is ON, line can be moved along X or Y direction only. Orthogonal 
mode is OFF to move in any direction. When a line is moved, the segment points are also moved by 
the displaced amount, except the points, which are lying, on the buses at both ends. 

 

Editing - If the orthogonal mode is ON, the point touched for moving is aligned with respect to 
previous point. The alignment can be along X or Y direction depending on the distance between the 
two points along X or Y direction. 

Connectivity - If the user tries to place a series element, connected to a same bus or elements 
other than transformer on to a different voltage level, an error message is popped up and connection 
is not accepted. 

Resize - The series element can be resized at any time by dragging a handle. 

1.5.11 Transmission Line 
 

Use  “Elements  −>Series  Elements−>Transmission   Line”  OR from     Power     System 
toolbar on the RHS of the screen to draw a transmission line between two different buses. The 
handles are highlighted whenever an object is selected for resizing or moving. To select a line, click 
mouse LMB on it. When both end connections are accepted and if the display code flag is ON, the 
code to show line from end and to end flows are placed beside the line. Move the display code to 
desired location if required. 

1.5.12 Two Winding Transformer 

Use  “Elements  −>Series  Elements−>Two  Winding  Transformer” OR  from Power 
System toolbar on the RHS of the screen to draw a two winding transformer between two different 
buses. The transformer can be resized at any time by dragging a handle shown at the two edges of 
a transformer. The handles highlight whenever an object is selected for resizing or moving. To select 
a transformer, click mouse LMB on it. When both end connections are accepted and if the display 
code flag is ON, the code to show transformer from end and to end flows and transformer tap value 
are placed beside the transformer. Place the code by moving it to the desired location if required. If 
the user tries to place a transformer connected to a same bus, an error message is popped up and 
connection is not accepted 

Procedure: 

Set the object layer from a menu item Set−>Object Layer to which transformer has to be 

placed. Set the orthogonal mode On/Off, so as to draw horizontal / vertical segments. 

Set the display code On/Off, so as to place display code or not. 

Set the transformer orientation angle with rotate button. The current object angle can be viewed on 
the status bar pane. 

Select the option from the menu item Power system−>Series Elements−>2 Winding  Transformer 
or from the Toolbar 

Place the cursor at desired location, click mouse LMB. The transformer is drawn at a specified 
location with a default size and orientation. The connection starts with From end side. 

Move the mouse to new location. As the cursor is dragged a line is shown which connects the 
transformer from end side and the mouse point as a preview of segment. Click mouse LMB to  
accept a segment. 

Repeat the above procedure to establish number of segments 

When the cursor is moved near the bus, the bus is highlighted 

Place mouse cursor on the Bus and double click mouse LMB to accept from end bus. The From end 
bus should be a high voltage bus. 

If double clicked position is on a bus, the From end connection is accepted and further connection is 
transferred to 'To End' side. Else an error message is shown to user and the double clicked point is 
considered as a segment. 

The procedure followed for From end side should be followed for To end connection also. 

If the To end bus indicated is same as From end bus, again the connection is not accepted and an 
error message is shown to the user. 



MiP-PSCT Power System Network Editor User Manual 

Power Research and Development consultants Pvt. Ltd. Page 32 

 

 

If the display code is ON, codes are placed adjacent to transformer. 

Use the resize handles for resizing / adjusting the segment(s) position. 

Note: 

No limitation on number of segments used on either side of a transformer. 

Click mouse RMB to ignore the drawing before establishing both end connections. 
 

No association exists between the display codes and power system elements. 

The points connected with a bus can be moved only along the bus. 

If the database is connected to the GUI, two winding transformer will be drawn with winding 
configuration 

1.5.13 Three Winding Transformer 

Use “Elements −> Series Elements −> Three Winding Transformer”  OR  from  Power 
System  toolbar  on  the  RHS  of  the  screen  to  draw  a     three  winding transformer 
between three different buses. The handles are highlighted whenever an object is selected for 
resizing or moving. To select a transformer click mouse LMB on it. Place the display code with the 
help of textbox to display the power system study results. If the user tries to place a transformer 
connected between same buses, an error message is popped up and connection is not accepted. 

If the database is connected to the GUI, three winding transformer will be drawn with winding 
configuration. 

Procedure: 

Set the object layer from a menu item Set−>Object Layer to which transformer is to be 

placed. Set the orthogonal mode On/Off, so as to draw horizontal / vertical segments. 

Set the display code On/Off, so as to place the display code or not. 

Set the transformer orientation angle with the help of the rotate button, the current angle can be 
viewed on a status bar pane. 

Select the option from a menu item Power system−>3 Winding Transformer or from a Toolbar 

Place the cursor at desired location. Click mouse LMB. The transformer is drawn at a specified 
location with a default size and orientation. The connection starts with primary end. 

Move the mouse to new location. As the cursor is dragged, a line is shown which is connects the 
transformer primary end side and the mouse point as a preview of segment. Click mouse LMB to 
accept the segment. 

Repeat the above procedure to establish number of segments 

Place the mouse cursor on a Bus and double click mouse LMB to accept the primary bus. The 
primary bus should be a high voltage bus. 

If double clicked position is on a bus, the primary end connection is accepted and further connection 
is transferred to secondary side. Else an error message is shown to user and the double clicked 
point is considered as a segment. 

The procedure followed for primary end side should be followed for secondary and tertiary end 
connections also. 

If the secondary end bus indicated is same as primary end bus, again the connection is not  
accepted and an error message is shown to the user. 

If the tertiary end bus indicated is same as primary end bus or secondary end bus, the connection is 
not accepted and an error message is shown to the user. 

Use the resize handles shown outside for resizing / adjusting the segment(s) position. 
 
1.5.14 Series Resistor 

 
Use  “Elements  −>Series  Elements−>  Resistor” OR from Power  System  toolbar  on  the 
RHS of the screen to draw a series resistor between two different buses. The handles are 
highlighted whenever an object is selected for resizing or moving. To select a resistor click mouse 
LMB on it. When both end connections are accepted and if the display code flag is ON, the code to 
show resistor From end and To end flows are placed beside the resistor. Move the display code to 
desired location if required. 
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1.5.15 Series Reactor 
 

Use  “Elements −>Series  Elements−>  Reactor” OR from Power System toolbar on the RHS 
of the screen to draw a series reactor between two different buses. The handles are highlighted 
whenever an object is selected for resizing or moving. To select a reactor click mouse LMB on it. 
When  both end connections are  accepted and if  the  display code flag is ON,  the code    to  show 

reactor From end and To end flows are placed beside the reactor. Move the display code to desired 
location if required. 

1.5.16 Series Capacitor 

Use  “Elements  −>Series  Elements−>  Capacitor”  OR  from   Power System toolbar on the 
RHS of the screen to draw a series capacitor between two different buses. The handles are 
highlighted whenever an object is selected for resizing or moving. To select a capacitor click mouse 
LMB on it. When both end connections are accepted and if the display code flag is ON, the code to 
show capacitor From end and To end flows are placed beside the capacitor. Move the display code 
to desired location if required. 

1.5.17 Bus Coupler Open 

Use   “Elements   −>Series   Elements−>Bus   Coupler   Open”   OR       from Power System 
toolbar on the RHS of the screen to draw a bus coupler with open status between two different 
buses. The coupler can be resized at any time by dragging the handle shown at the two edges of a 
coupler. The handles are highlighted whenever an object is selected for resizing or moving. To 
select a coupler, click mouse LMB on it. When both end connections are accepted and if the display 
code flag is ON, the code to show coupler from end and to end power flows are placed beside the 
coupler. Place the code by moving it to the desired location if required. If the user tries to place a 
coupler connected to a same bus, an error message is popped up and connection is not accepted. 

1.5.18 Bus Coupler Closed 

Use  “Elements  −>Series  Elements−>Bus  Coupler  Closed”  OR       from Power System 
toolbar on the RHS of the screen to draw a bus coupler with closed status between two different 
buses. The coupler can be resized at any time by dragging a handle shown at the two edges of a 
coupler. The handles are highlighted whenever an object is selected for resizing or moving. To 
select a coupler click mouse LMB on it. When both end connections are accepted and if the display 
code flag is ON, the code to show coupler from end and to end flows are placed beside the coupler. 
Place the code by moving it to the desired location if required. If the user tries to place a coupler 
connected to a same bus, an error message is popped up and connection is not accepted. 

ETA 

Electromagnetic transient analysis (ETA) elements 

• Instantaneous current source 

• Impulse current source 

• RMS current source 

• Instantaneous voltage source 

• Impulse voltage source 

• RMS voltage source 

• Lightning arrestor 

• Delta connected load 

• Arc Fault 

• Vacuum circuit breaker - open 
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• Vacuum circuit breaker – closed 

• Metal Oxide Varistor 

• Spark Gap 

• Shunt Resistor 
 

 

1.5.19 Instantaneous Current Source 
 

Use  “Elements  −>ETA  elements−>Instantaneous  Current  Source” OR  from Power 
System toolbar on the RHS of the screen to draw an instantaneous current          source.       Double 
click on the selected bus. The current source can be resized at any time by dragging the handle 
shown at the two edges of a current source. The handles are highlighted whenever an object is 
selected for resizing or moving. To select a current source, click mouse LMB on it. If the user tries to 
place a current source other than on a bus, an error message is popped up and current source 
connection is not accepted. 

1.5.20 Impulse Current Source 

Use  “Elements  −>ETA  Elements−>Impulse  Current  Source”  OR   from power System 
toolbar on the RHS of the screen to draw an impulse current source. The current source can be 
resized at any time by dragging a handle shown at the two edges of a current source. The handles 
are highlighted whenever an object is selected for resizing or moving. To select a current source, 
click mouse LMB on it. If the user tries to place a current source other than on a bus, an error 
message is popped up and current source connection is not accepted. 

1.5.21 RMS Current Source 
 

Use “Elements −>ETA Elements−>RMS Current Source” OR     from  Power System  toolbar on 
the RHS of the screen to draw a RMS current source. The current source can be resized at any time 
by dragging a handle shown at the two edges of a current source. The handles are highlighted 
whenever an object is selected for resizing or moving. To select a current source click mouse LMB 
on it. If the user tries to place a current source other than on a bus, an error message is popped up 
and current source connection is not accepted. 

1.5.22 Instantaneous Voltage Source 

Use “Elements −>ETA Elements−>Instantaneous Voltage Source” OR from Power System 
toolbar on the RHS of the screen to draw an Instantaneous Voltage source. The voltage source can 
be resized at any time by dragging a handle shown at the two edges of a voltage source. The 
handles are highlighted whenever an object is selected for resizing or moving. To select a voltage 
source click mouse LMB on it. If the user tries to place a current source other than on a bus, an error 
message is popped up and voltage source connection is not accepted. 

1.5.23 Impulse Voltage Source 

Use “Elements −>ETA Elements−>Impulse Voltage Source” OR   from Power System toolbar 
on the RHS of the screen to draw an Impulse Voltage source. The voltage source can be resized at 
any time by dragging a handle shown at the two edges of a voltage source. The handles are 
highlighted whenever an object is selected for resizing or moving. To select a voltage source click 
mouse LMB on it. If the user tries to place a current source other than on a bus, an error message is 
popped up and voltage source connection is not accepted. 

 

1.5.24 RMS Voltage Source 

Use “Elements −>ETA Elements−>RMS Voltage Source” OR   from Power System toolbar 
on the RHS of the screen to draw an RMS Voltage source. The voltage source can be resized at any 
time by dragging a handle shown at the two edges of a voltage source. The handles are highlighted 
whenever an object is selected for resizing or moving. To select a voltage source click mouse LMB 
on it. If the user tries to place a current source other than on a bus, an error message is popped up 
and voltage source connection is not accepted. 
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1.5.25 Lightning Arrestor 

 
Use  “Elements  −>ETA  Elements−>Lightning  Arrestor”  OR      from   Power   System   toolbar 
on the RHS of the screen to draw a lightning arrestor (LAR). The LAR can be resized at any time by 
dragging a handle shown at the two edges of a LAR. The handles are highlighted whenever an 
object is selected for resizing or moving. To select a LAR, click mouse LMB on it. If the user tries  to 

 

place a LAR other than on a bus, an error message is popped up and LAR connection is not 
accepted. 

1.5.26 Delta Connected Load 

Use  “Elements  −>ETA  Elements−>Delta  Connected  Load”  OR   from Power System 
toolbar on the RHS of the screen to draw a delta connected load. The load can be resized at any 
time by dragging a handle shown at the two edges of a load. The handles are highlighted whenever 
an object is selected for resizing or moving. To select a load click mouse LMB on it. If the user tries 
to place a load other than on a bus, an error message is popped up and load is not accepted. 

 
 
1.5.27 Arc Fault 

Use “Elements −>ETA Elements−>Arc Fault” OR from Power System toolbar on the RHS of 
the screen to draw an Arc Fault. The handles are highlighted whenever an object is selected for 
resizing or moving. To select an Arc Fault, click mouse LMB on it. If the display code flag is ON, the 
code to show Arc fault real and reactive power flows are placed in line with the Arc fault. Place the 
code by moving it to the desired location if required. If the user tries to place an Arc Fault other than 
on a bus, an error message is popped up and Arc Fault connection is not accepted. 

1.5.28 Vacuum Circuit Breaker-open 

Use “Elements −>ETA Elements−>Vacuum Circuit Breaker-open” OR   from Power System 
toolbar on the RHS of the screen to draw a vacuum circuit breaker (VCB) with open status. The VCB 
can be resized at any time by dragging a handle shown at the two edges of a VCB. The handles are 
highlighted whenever an object is selected for resizing or moving. To select a VCB, click mouse  
LMB on it. If the user tries to place a VCB connected to a same bus, an error message is popped up 
and connection is not accepted. Switching - Select a VCB. Click the right mouse button with mouse 
cursor on the VCB. Select Status−>Close, to close VCB. Else Status−>Open, to open VCB. The 
same option is available with a menu item Change−>Status−>Open/Close 

 
 
1.5.29 Vacuum Circuit Breaker-closed 

Use “Elements −>ETA Elements−>Vacuum Circuit Breaker-closed” OR  from Power 
System toolbar on the RHS of the screen to draw a vacuum circuit breaker (VCB) with closed status. 
The VCB can be resized at any time by dragging a handle shown at the two edges of a VCB. The 
handles are highlighted whenever an object is selected for resizing or moving. To select a VCB click 
mouse LMB on it. If the user tries to place a VCB connected to the same bus, an error message is 
popped up and the connection is not accepted 

 
 
1.5.30 Metal Oxide Varistor 

Use   “Elements   −>ETA   Element−>MOV”   OR       from Power System toolbar on the RHS of 
the screen to draw a MOV between two different buses. The handles are highlighted whenever an 
object is selected for resizing or moving. To select a MOV click mouse LMB on it. When both end 
connections are accepted. 

 
 
1.5.31 Spark Gap 

 
Use “Elements −>ETA Element−>Spark Gap” OR Power  System  toolbar  on  the  RHS  of 
the screen to draw a Spark Gap between two different buses. The handles are highlighted whenever 
an object is selected for resizing or moving. To select a Spark Gap click mouse LMB on it. When 
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both end connections are accepted. 
 
 
1.5.32 Shunt Resistor 

Use “Elements −>ETA Elements−>Shunt Resistor” OR from   Power System toolbar on the 
RHS of the screen to draw a shunt resistor. The handles are highlighted whenever the object is 

selected for resizing or moving. To select a resistor, click mouse LMB on it. If the display code flag is 
ON, the code to show resistor real and reactive power flows are placed in line with the resistor. 
Place the code by moving it to the desired location if required. 

 
 

HVDC 
 

HVDC Elements 

• HVDC Rectifier 

• HVDC Inverter 

• DC Link 

• Filter 

1.5.33 HVDC Rectifier 
 

Use “Elements −>HVDC Elements−>HVDC Rectifier”  OR from Power   System  toolbar  on 
the RHS of the screen to draw a HVDC rectifier. The rectifier can be resized at any time by dragging 
a handle shown at the two edges of the rectifier. The handles are highlighted whenever an object is 
selected for resizing or moving. To select a rectifier, click mouse LMB on it. If the user tries to place 
a rectifier not on a bus, an error message is popped up and rectifier is not accepted. 

Switching - Select a rectifier. Select the option from the menu item as Edit−>Change HVDC 
Element−>Inverter or the context menu item as Change HVDC Element−>Inverter to change from 
rectifier to inverter and vice-versa. The option is valid only for HVDC elements. 

1.5.34 HVDC Inverter 
 

Use  “Elements  −>HVDC  Elements−>HVDC  Inverter”  OR from  Power  System toolbar on 
the RHS of the screen to draw a HVDC inverter. The inverter can be resized at any time by dragging 
a handle shown at the two edges of inverter. The handles are highlighted whenever an object is 
selected for resizing or moving. To select an inverter, click mouse LMB on it. If the user tries to place 
an inverter not on a bus, an error message is popped up and inverter is not accepted. 

Switching - Select an inverter. Select the option from the menu item as Edit−>Change HVDC 
Element−>rectifier or the context menu item as Change HVDC Element−>rectifier to change from 
inverter to rectifier and vice-versa. The option is valid only for HVDC elements. 

 
 
1.5.35 DC Link 

 
Use “Elements −>HVDC Elements−>DC Link” OR from Power System toolbar on the RHS of 
the screen to draw a DC Link between two HVDC convertor stations. The link can be resized at any 
time by dragging a handle shown at the two edges of a link. The handles are highlighted whenever 
an object is selected for resizing or moving. To select a link, click mouse LMB on it. When both the 
end connections are accepted and if the display code flag is ON, the code to show link from end and 
to end flows are placed beside the link. Place the code by moving it to the desired location if 
required. If the user tries to place a link connected to same HVDC convertor station, an error 
message is popped up and connection is not accepted. 

Procedure: 

Set the object layer from the menu item Set−>Object Layer to which DC link is to be 

placed. Set the orthogonal mode On/Off, so as to draw horizontal / vertical segments. 
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Set the display code On/Off, so as to place the code or not. 

Set the link orientation angle with a rotate button. The current object angle can be viewed on a  
status bar pane. 

Select the option from a menu item Power system−>HVDC Elements−>DC Link or from a power 
system Toolbar  

 

Place the cursor at desired location, click mouse LMB. The link is drawn at that location with default 
size and orientation. The connection starts with From end side. 

Move the mouse to new location. As the cursor is dragged, a line is shown which is connects the  
link From end side and the mouse point as a preview of segment. Click mouse LMB to accept a 
segment. 

Repeat the above step to establish number of segments 

Place a mouse cursor on a HVDC rectifier/Inverter and the double click mouse LMB to accept the 
from end connection. 

If double clicked position is on a HVDC rectifier /Inverter, the From end connection is accepted and 
further connection is transferred to To end side. Else an error message is shown to user and the 
double clicked point is considered as a segment. 

The procedure followed for From end side connection should be followed for to end connection also. 

If the To end HVDC equipment indicated is same as from end HVDC equipment, again the 
connection is not accepted and an error message is popped up. 

If the display code is ON, codes are placed adjacent to DC Link. 

Use the resize handles shown outside for resizing / adjusting the segment(s) position. 

Note: 

No limitation on number of segments used on either side of a DC Link. 

Click mouse RMB to ignore the drawing before establishing both end connections. 

No association exists between the display codes and power system elements. 

The points connected with a HVDC equipment can be moved only along HVDC rectifier /Inverter. 

1.5.36 Filter 

Use   “Elements−>HVDC   Element−>Filter”   OR      from Power System toolbar on the RHS 
of the screen to draw a filter connected to a bus. The filter can be resized at any time by dragging 
the handle shown at the two edges of the filter. The handles are highlighted whenever an object is 
selected for resizing or moving. To select a filter click mouse LMB on it. If the display code flag is 
ON, the code to show filter real and reactive power flows are placed in line with the filter. Place the 
code by moving it to the desired location, if required. If the user tries to place a filter other than on a 
bus, an error message is popped up and filter connection is not accepted. 

FACTS 

FACTS 

• Shunt FACTS Device (SFD) 

• Static VAR Compensator (SVC) 

• Unified Power Flow controller (UPFC) 

• Thyristor controlled series capacitor (TCSC) 

• Static Phase Shifter (SPS) 

• FACTS Generic 
 
 
1.5.37 FACTS Generic 

 
Use   “Elements−>FACTS−>FACTS  Generic”  OR from Power System toolbar on the RHS 
of the screen to draw FACTS between two different buses. The handles are highlighted whenever 
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an object is selected for resizing or moving. To select a FACTS click mouse LMB on it. When both 
end connections are accepted and if the display code flag is ON, the code to show FACTS From  
end and To end flows are placed beside the FACTS. Move the display code to desired location if 
required. 

Following are the series facts devices 

 

 
 

Unified Power flow Controller -from power system tool bar 
 

Thyristor Controlled Series Capacitor -from power system tool bar 

Static    Phase    Shifter    -       from power system tool bar 

Use Power System > Series Elements >> FACTS >> FACTS Generic OR from Power     System toolbar on the RHS of the screen to draw FACTS between two different buses. 
The handles are highlighted whenever an object is selected for resizing or moving. To select a 
FACTS click mouse LMB on it. When both end connections are accepted and if the display code flag 
is ON, the code to show FACTS From end and To end flows are placed beside the FACTS. Move 
the display code to desired location if required. 

Drawing – Drop the series element in-between the buses. Automatically a connecting line starts 
following the mouse pointer. Move the mouse on to a bus and double click to connect From side 
connection. Another connecting line automatically starts towards the To side connection. Drag the 
mouse towards the TO side connection and double click on the bus to establish the TO side 
connection. If connection is accepted, the Display Code appears.  Keeping the orthogonal mode  
ON, connecting line segments can be drawn either horizontal or vertical only. Orthogonal mode is 
OFF to draw a connecting line inclined at any angle. 

Rotation – Select the object and click the rotate button. Object is rotated in steps of 90 degrees; 
Connecting points to bus remain same. 

Moving - If the orthogonal mode is ON, line can be moved along X or Y direction only. Orthogonal 
mode is OFF to move in any direction. When a line is moved, the segment points are also moved by 
the displaced amount, except the points, which are lying, on the buses at both ends. 

Editing - If the orthogonal mode is ON, the point touched for moving is aligned with respect to 
previous point. The alignment can be along X or Y direction depending on the distance between the 
two points along X or Y direction. 

Connectivity - If the user tries to place a series element, connected to a same bus or elements 
other than transformer on to a different voltage level, an error message is popped up and connection 
is not accepted. 

Resize - The series element can be resized at any time by dragging a handle. 

The same procedure is followed for UPF, TCSC and SPS. 

1.5.38 Shunt Facts Device 

Use “Elements −>Shunt Elements−>Shunt Facts Device”  OR      from Power  System  
toolbar on the RHS of the screen to draw a shunt facts device. The handles are highlighted 
whenever an object is selected for resizing or moving. To select a shunt facts device, click mouse 
LMB on it. If the display code flag is ON, the code to show shunt fact device real and reactive power 
flows are placed in line with the shunt facts device. Place the code by moving it to the desired 
location if required. If the user tries to place a shunt facts device other than on a bus, an error 
message is popped up and shunt facts device connection is not accepted. 

1.5.39 Static VAR Compensator 
 

Use “Elements  −>ETA  Elements−>Static  VAR  Compensator”  OR  from  Power  System  
toolbar on the RHS of the screen to draw a static VAR compensator (SVC). The SVC can be resized 
at any time by dragging a handle shown at the two edges of a SVC. The handles are highlighted 
whenever an object is selected for resizing or moving. To select a SVC, click mouse LMB on it. If the 
display code flag is ON, the code to show SVC real and reactive flows are placed in line with the 
SVC. Place the code by moving it to the desired location if required. If the user tries to place a SVC 
other than on a bus, an error message is popped up and SVC connection is not accepted. 

FACTS Generic-- from power system tool bar 
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PROTECTION 
 

Protection Elements 

• Current Transformer 

• Potential Transformer 

• Capacitive Voltage Transformer (CVT) 

• Relay 

• Fuse 

• Meters 

o Ammeter 

o Voltmeter 

o Multimeter 

o Measurement Data 

1.5.40 Current Transformer 
 

Use “Elements −>Accessories−>Current Transformer ” OR from Power System toolbar on the 
RHS of the screen to place a current transformer at desired location. The handles are highlighted 
whenever an object is selected for resizing or moving. To select a current transformer, click mouse 
LMB on it. Connect the relay to the CT and while placing it terminates on CT. If the GUI is connected 
to the database, CT ratio appears along with the CT. 

1.5.41 Potential Transformer 
 

Use “Elements −>Accessories−> Potential Transformer ” OR from Power System toolbar 
on the RHS of the screen to place a Potential transformer at desired location. The handles are 
highlighted whenever an object is selected for resizing or moving. To select a Potential transformer, 
click mouse LMB on it. 

 

1.5.42 Relay 
 

Use  “Power  System−>Accessories−>Relay”  OR from Power System toolbar on the RHS 

of the screen to place a Relay at desired location. The handles are highlighted whenever an object  
is selected for resizing or moving. This will terminate on CT while drawing. To select a Relay, click 
mouse LMB on it. 

1.5.43 Fuse 
 

Use   “Power  System−>Accessories−>Fuse”  OR from   Power   System   toolbar on  the 
RHS of the screen to place a Fuse at desired location. The handles are highlighted whenever an 
object is selected for resizing or moving. To select a Fuse, click mouse LMB on it. 

 
 
1.5.44 Capacitive Voltage Transformer 

 
Use “Power System−>Shunt Elements−>Capacitive Voltage Transformer” OR  from Power 
System toolbar on the RHS of the screen to draw a CVT. The handles are highlighted whenever an 
object is selected for resizing or moving. To select a CVT, click mouse LMB on it. If the display code 
flag is ON, the code to show CVT real and reactive power flows are placed in line with the CVT. 
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Place the code by moving it to the desired location if required. If the user tries to place a CVT other 
than on a bus, an error message is popped up and CVT connection is not accepted. 

 
 
1.5.45 Voltmeter 

Use   “Power   System−>Meters−>Voltmeter”   OR       from Power System toolbar on the RHS 
of the screen to place a voltmeter symbol at desired location. The handles are highlighted whenever 
an object is selected for resizing or moving. To select a voltmeter, click mouse LMB on it. 

1.5.46 Ammeter 
 

Use   “Power   System−>Meters−>Ammeter”   OR      from Power System toolbar on the RHS   
of  the  screen  to  place  a  voltmeter   symbol  at desired   location.       The   handles   are 
highlighted whenever an object is selected for resizing or moving. To select a voltmeter, click mouse 
LMB on it. 

1.5.47 Multimeter 

Use  “Power  System−>Meters−>Multimeter”  OR       from  Power System  toolbar on the RHS 
of the screen to place a Multimeter at desired location. The handles are highlighted whenever an 
object is selected for resizing or moving. To select a Multimeter, click mouse LMB on it. 

Drawing-Drop the Meter element where the meter should be drawn.  Automatically a connecting  
line starts following the mouse pointer. Move the mouse on to a bus/Meter/power system element 
and double click to connect to the element. By default the meter connections are drawn in green 
dotted line. User can change the properties if required. 

Rotation - Select a meter.  Click the rotate button.  Meter is rotated in steps of 90 degrees. 

Resizing - Use the 8 points shown around the symbol for resizing. Increase the distance between 
the handles to inflate symbol OR decrease the distance between handles to deflate symbol. 

Moving - If the orthogonal mode is ON, meter can be moved along X or Y direction only.  
Orthogonal mode is OFF to move in any direction. 

Resize - The meter can be resized at any time by dragging a handle shown around a meter 
 
 
1.5.48 Measurement Data 

 

Use “Elements −>Protection−>Meters-> Measurement Data  ” OR      from Power System 
toolbar on the RHS of the screen to place a Measurement Data at desired location. The handles are 
highlighted whenever an object is selected for resizing or moving. To select a Measurement Data, 
click mouse LMB on it. If the GUI is connected to the database, Measurement Data form will open. 

 
 

SYMBOLS 

• Four Winding Transformer 

• Isolator open 

• Isolator closed 

• Breaker Open 

• Breaker Closed 

• LV Breaker 
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• Star 

• Star Ground 

• Delta 

• Ground 

• Neutral Grounding Resistor 

• Dynamic Link 

• Bounded Text 

• Battery 

• Battery Charger 

• Capacitor Bank 

• Power System Block (PSB) 

• Non-Directional IDMT 

• Directional IDMT 

• Distance – Mho Characteristic 

• Distance – Quad Characteristic 

Drawing – Select one of the symbols from the power system toolbar or from menu option “Power 
system−>symbol”. Place mouse pointer at the location, where symbol has to be drawn and click 
left mouse button to draw the selected symbol. 

Rotation - Select a symbol.  Click the rotate button.  Symbol is rotated in steps of 90 degrees. 

Resizing - Use the 8 points shown around the symbol for resizing. Increase the distance between 
the handles to inflate symbol OR decrease the distance between handles to deflate symbol. 

Moving - If the orthogonal mode is ON, symbol can be moved along X or Y direction only. 
Orthogonal mode is OFF to move in any direction. 

Resize - The symbol can be resized at any time by dragging a handle shown around a symbol. 
 
 
1.5.49 Four Winding Transformer 

Use  “Elements  −>Four  Winding  Transformer”  OR   from Power System toolbar on the 
RHS of the screen to draw a four winding transformer between four different buses. The handles are 
highlighted whenever an object is selected for resizing or moving. To select a transformer, click 
mouse LMB on it. Place the display code with the help of textbox to display the power system study 
results. If the user tries to place a transformer connected between same buses, an error message is 
popped up and connection is not accepted. 

Procedure: 

Set the object layer from a menu item Set−>Object Layer to which transformer is to be 

placed. Set the orthogonal mode On/Off, so as to draw horizontal / vertical segments. 

Set the display code On/Off, so as to place a code or not. 

Set the transformer orientation angle with help of the rotate button. The current angle can be viewed 
on a status bar pane. 

Select the option from a menu item Power system−>4 Winding Transformer or from a Toolbar 

Place the cursor at desired location. Click mouse LMB. The transformer is drawn at a specified 
location with a default size and orientation. The connection starts with primary end. 

Move the mouse to new location. As the cursor is dragged, a line is shown which connects the 
transformer primary end side and the mouse point as a preview of segment. Click a mouse LMB to 
accept a segment. 

Repeat the above step to establish number of segments 

Place the mouse cursor on a Bus and double click mouse LMB to accept a primary connection. 
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If double clicked position is on a bus, the primary end connection is accepted and further connection 
is transferred to secondary side. Else an error message is shown to user and a double clicked point 
is considered for a segment. 

The steps followed to connect primary end side should be followed for secondary, tertiary and fourth 
winding end connection also. 

If the secondary end bus indicated is same as primary end bus, again the connection is not  
accepted and an error message is shown to the user. 

If the tertiary end bus indicated is same as primary end bus or secondary end bus, the connection is 
not accepted and an error message is shown to the user. 

If the fourth winding bus indicated is same as primary end bus or secondary end bus or tertiary end 
bus, the connection is not accepted and an error message is shown to the user. 

Use the resize handles shown outside for resizing / adjusting the segment(s) position. 

Note: 

Click mouse RMB to ignore the drawing before establishing connection. 

No association exists between the display codes and power system elements. 

The points connected with a bus can be moved only along the bus. 

Breakers 

Isolator open 

Isolator closed 

Switching - To select the coupler, click the right mouse button with the mouse cursor on the  
coupler. Select the Status−>Close, to close bus coupler. Else Status−>Open, to open bus coupler. 
The same option is available with the menu item Edit−>Status−>Open/Close. 

Rotation - Select the coupler. Click on the rotate button. Coupler is rotated by 90 degrees. 
Connecting points on the bus remain without any modifications. 

Drawing - Keeping the orthogonal mode ON, connecting line segments can be drawn either 
horizontal or vertical only. Turn OFF orthogonal mode to draw a connecting line inclined at any 
angle. 

Moving - If the orthogonal mode is ON, coupler can be moved along X or Y direction only. Turn OFF 
to move in any direction. When a coupler is moved, the segment points are also moved by the 
displaced amount except the points, which are lying, on the buses at both ends. 

Editing - If the orthogonal mode is ON, the point touched for moving is aligned with respect to 
previous point. The alignment can be along X or Y direction depending on the distance between the 
two points is more along X or Y direction. 

 
1.5.50 Isolator Open 

 
Use   “Power   System−>Breakers−>Bus   Coupler Open”  OR from  Power System toolbar 
on the RHS of the screen to draw an Isolator with open status between two different buses. The 
isolator can be resized at any time by dragging the handle shown at the two edges of an isolator. 
The handles are highlighted whenever an object is selected for resizing or moving. To select an 
isolator click mouse LMB on it. When both end connections are accepted and if the display code flag 
is ON, the code to show isolator from end and to end flows are placed beside the isolator. Place the 
code by moving it to the desired location if required. If the user tries to place an isolator connected to 
a same bus, an error message is popped up and connection is not accepted. 

 
 
1.5.51 Isolator Closed 

Use   “Power   System−>Breakers−>Bus   coupler   open”   OR   from Power System toolbar 
on the RHS of the screen to draw an Isolator with closed status between two different buses. The 
isolator can be resized at any time by dragging a handle shown at the two edges of an isolator. The 
handles are highlighted whenever an object is selected for resizing or moving. To select an isolator 
click mouse LMB on it. When both end connections are accepted and if the display code flag is ON, 
the code to show isolator from end and to end flows are placed beside the isolator. Place the code  
by moving it to the desired location if required. If the user tries to place an isolator connected to a 
same bus, an error message is popped up and connection is not accepted. 
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1.5.52 Star 
 

Use “Power System−>Symbols−>Star” OR from Power System toolbar on the RHS of the 
screen to place a Star symbol at desired location. The handles are highlighted whenever the object  
is selected for resizing or moving. To select a symbol, click mouse LMB on it. The user can change 
the symbol from one to other, without deleting the existing symbol. 

Switching - Select a Symbol. Select the option from a menu item as Change−> Symbol Type−>Star 
Grounded, Delta, and Ground..... or the context menu item as Change Symbol Type Star Grounded, 
Delta, Ground ... to change from one type to other and vice-versa. This option is valid only for 
symbols. 

1.5.53 Star Grounded 

Use “Power System−>Symbols−>Star grounded”  OR from Power System toolbar  on  the  
RHS of the screen to place a Star Grounded symbol at desired location. The handles  are 
highlighted whenever the object is selected for resizing or moving. To select a symbol, click mouse 
LMB on it. The user can change the symbol from one to other, without deleting the existing symbol. 

Switching - Select a Symbol. Select the option from a menu item as Change−>Symbol Type−>Star, 
Delta, and Ground..... or the context menu item as Change Symbol Type Star, Delta, Ground, to 
change from one type to other and vice-versa. This option is valid only for symbols. 

 
 
1.5.54 Delta 

 
Use “Power System−>Symbols−>Delta” OR from Power System toolbar on  the  RHS  of  the 
screen to place a Delta symbol at desired location. The handles are highlighted whenever an object 
is selected for resizing or moving. To select a symbol, click mouse LMB on it. The user can change 
the symbol from one to other, without deleting the existing symbol. 

Switching - Select a Symbol. Select the option from a menu item as Change−>Symbol Type−>Star, 
Star Grounded, Ground ... or the context menu item as Change Symbol Type Star, Star Grounded, 
Ground, ..... to change from one type to other and vice-versa. This option is valid only for symbol(s). 

1.5.55 Ground 
 

Use “Power System−>Symbols−>Ground” OR from Power System toolbar on the RHS of the 
screen to place a Ground symbol at desired location. The handles are highlighted whenever an 
object is selected for resizing or moving. To select a symbol, click mouse LMB on it. The user can 
change the symbol from one to other, without deleting the existing symbol. 

Switching - Select a Symbol. Select the option from a menu item as Change−>Symbol Type−>Star, 
Star Grounded, Delta ....or the context menu item as Change Symbol Type Star, Star Grounded, 
Delta, ..... to change from one type to other and vice-versa.  This option is valid only for symbols. 

1.5.56 Neutral Grounding Resistor 
 

Use  “Power  System−>Symbol−>Neutral  Grounding  Resistor”  OR from Power System 
toolbar on the RHS of the screen to place a neutral grounding resistor symbol at desired location. 
The handles are highlighted whenever an object is selected for resizing or moving. To select a 
symbol, click mouse LMB on it. 

1.5.57 Breaker – Open 
 

Use “Power System−>Symbols−>Breaker  Open” OR from Power System toolbar   on the 
RHS of the screen to place a breaker - open symbol at desired location. The handles are highlighted 
whenever an object is selected for resizing or moving. To select a symbol, click mouse LMB on it. 
The user can change the symbol from one to other, without deleting the existing symbol. 

Switching - Select a Symbol. Select the option from a menu item as Change−>Symbol 
Type−>Breaker close , ..... or the context menu item as Change Symbol Type−> Breaker close, ..... 
to change from one type to other and vice-versa. This option is valid only for power system symbols. 

1.5.58 Breaker – Closed 

Use “Power System−>Symbols−>Breaker Closed” OR       from Power  System  toolbar  on  
the RHS of the screen to place a breaker - closed symbol at desired location. The handles are 
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highlighted whenever an object is selected for resizing or moving. To select a symbol, click mouse 
LMB on it. The user can change the symbol from one to other, without deleting the existing symbol. 

Switching - Select a Symbol. Select the option from a menu item as Change−>Symbol Type−> 
Breaker open,. or the context menu item as Change−>Symbol Type−>Breaker open, ..... to change 
from one type to other and vice-versa. This option is valid only for power system symbols. 

 
 
1.5.59 LV Breaker 

 
Use  “Power  System−>Symbols−>LV  Breaker” OR from  Power  System  toolbar  on  the 
RHS of the screen to place a LV breaker - closed symbol at desired location. The handles are 
highlighted whenever an object is selected for resizing or moving. To select a symbol, click mouse 
LMB on it. The user can change the symbol from one to other, without deleting the existing symbol. 

 
 
1.5.60 Dynamic Link 

 
Use “Power System−>Symbols−>Dynamic 
Link” OR   from Power System toolbar   on the 
RHS    of the  screen  to  place  a  dynamic  link  at 
desired location. The following dialog box appears. The 
handles 

 
 

are highlighted whenever an object is selected for resizing or moving. 

Enter the name of the link and select the network file, which should be opened when you click on the 
dynamic link. To edit a dynamic link, hold CTRL and double click on the link. 

1.5.61 Bounded Text 
 

Use “Power System−>Symbols−>Bounded Text” OR from  Power  System  toolbar on the 
RHS of the screen to place a bounded text. The handles are highlighted whenever an object is 
selected for resizing or moving. To select a symbol, click mouse LMB on it. To edit the bounded 
shape and the text, hold CTRL and double click on the symbol. 

 
 
 

1.5.62 Capacitor Bank 
 

Use “Power System−>Symbols−>Capacitor Bank” place a capacitor bank at desired location. The 
handles are highlighted whenever an object is selected for resizing or moving. To select a symbol, 
click mouse LMB on it. 

1.5.63 Non -Directional IDMT 
 

Use  “Power  System−>Relay−>Non  -Directional IDMT” 
OR   from Power System toolbar on the RHS of the 

screen  to  place  a  non-directional  IDMT   relay 
symbol at desired location. The handles are highlighted 
whenever an object is selected for resizing or moving. To 
select a symbol, click mouse LMB on it. The user can 
change the symbol from one to other, without deleting the 
existing symbol. 

Switching - Select a Symbol. Select the option from a 
menu item as  Change−>Relay Type−>Directional  IDMT, 
Distance Relay-Mho, ..... or the context menu item as Change−>Relay Type−>Directional IDMT, 
Distance Relay-Mho, ..... to change from one type to other and vice-versa. This option is valid only 
for relay symbols. 

 
1.5.64 Directional IDMT 

Use “Power System−>Relay−>Directional IDMT”  OR from Power System toolbar on the  RHS 
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of the screen to place a directional IDMT relay symbol at desired location. The handles are 
highlighted whenever an object is selected for resizing or moving. To select a symbol, click mouse 
LMB on it. The user can change the symbol from one to other, without deleting the existing symbol. 

Switching - Select a Symbol. Select the option from a menu item as Change−>Relay 
Type−>Directional IDMT, Distance Relay-Mho, ..... or the context menu item as Change−>Relay 
Type−>Directional IDMT, Distance Relay-Mho, ..... to change from one type to other and vice-versa. 
This option is valid only for relay symbols. 

1.5.65 Distance Relay – Mho 

Use  “Power  System−>Relay−>Distance  Relay  -  Mho”  OR from Power System toolbar on 
the RHS of the screen to place, a distance relay - mho characteristic symbol at desired location. To 
select a symbol, click mouse LMB on it. The user can change the symbol from one to other, without 
deleting the existing symbol. 

Switching - Select a Symbol. Select the option from a menu item as Change−>Relay 
Type−>Directional IDMT, Distance Relay-Mho, ..... or the context menu item as Change−>Relay 
Type−> Directional IDMT, Distance Relay-Mho, .... to change from one type to other and vice-versa. 
This option is valid only for relay symbols. 

1.5.66 Distance Relay –Quad 

Use  “Power  System−>Relay−>Distance  Relay -  Quad”  OR from Power System toolbar on 
the RHS of the screen to place a distance relay - quadrilateral characteristic symbol at desired 
location. To select a symbol, click mouse LMB on it. The user can change the symbol from one to 
other, without deleting the existing symbol. 

Switching - Select a Symbol. Select the option from a 
menu item as Change−>Relay Type−>Directional 
IDMT, Distance Relay-Mho, ..... or the context menu 
item as Change−>Relay Type−>Directional IDM, 
Distance Relay-Mho, ..... to change from one type to 
other and vice-versa. This option is valid only  for 
relay symbols. 

 
 
 

1.5.67 Battery 
 

Use  “Power  System−>Battery  ”   OR 
from Power System toolbar on the RHS of the screen 
to place a Battery at desired location. The handles  
are highlighted whenever an object is selected for 
resizing or moving. To select a Battery, click mouse 
LMB on it. 

1.5.68 Battery Charger 
 

Use  “Power  System−>Battery  Charger”  OR from Power System toolbar on the  RHS of 
the screen to place a Battery Charger at desired location. The handles are highlighted whenever an 
object is selected for resizing or moving. To select a Battery Charger, click mouse LMB on it. 

 
 
1.5.69 Power System Block 

 
Use “Power System−>Insert Block” This option inserts a Power system block into the existing 
Network and database. Select this option from menu Power system->Insert Block or select from the 

power system toolbar . This opens the Block-Details dialog box. Browse for the network or SLD 
file which is to be inserted. Give new ID for the elements present in the block and click on Update 
button. The block (SLD) with new IDS inserted in the opened SLD and the database is also updated 
with new block. Provision is provided to insert the block with CTs and relays. This is useful when 
same block is to be inserted repeatedly in the existing network. Block inserted in the network is 
shown below. Inserted block is highlighted. 

Element: Elements present in the block which is to be inserted are displayed. 
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Old ID: Element IDs of the inserted block are displayed 

New IDs: New IDs are appeared. User can also specify new IDs for the elements. 

New Name: New names are appeared. User can also specify new name for the elements 

Vol/library/MVA: Voltage / Library no/ MVA rating of the element is to be specified 

Bus Description: Bus details can be entered. 

Current Transformer: New ID, New Name, CT 
Primary, CT Secondary and CT location for the 
inserted block is displayed. 

Relays: Relay type and OLD ID, New ID, New name 
of the inserted block will be displayed. User can also 
enter the details. 

 
 
 

Update: Inserts the block into the database 

OK: Inserts the block in the opened network and 
close the screen 

Cancel: Without inserting block close the dialog. 

For relays updations with insert block option follow 
the procedure 

Select the transformer without ZZ codes and CT and 
connect them using connect meter option. 

Select CT and Relay and connect them using 
connect meter option. 

Insert the block and update the data. A sample data shown below. 

Note: Relay primary CT ID’s should be the Old CT ID’s. Secondary CT ID’s are used for Distance 
Relay for other relays let it be default. 

1.5.70 Create Search Index 
 

An option to search the Bus name in all the open GUI’s or GUI’s 
in a directory is provided. This option will be useful when there 
are many sub-networks associated with the same database. 

Open a new GUI. Select menu option Create > Search 

Index. A Search Element dialog box appears. Browse for the 
directory where all GUIs related to the same database are 
located. Select a GUI. All networks presented in the directory 
will be listed. Select the GUIs and click Add button 

Add – to add a file from the Files list box to Selected Files list 
box. 

Add All – to add all the files to Selected Files list box. 

Remove – to remove a file from Selected Files list 
box. 

Remove All – to remove all the files from Selected 
Files list box. 
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OK – to List the bus names presented in the selected networks 

Cancel – to cancel the search index process 

Bus numbers presented in the selected Networks will appear on the GUI file which is opened. 
Choose the bus number to be searched from the selected networks. The respective Network with 
highlighted bus number will be opened. 

Start: Select some GUIs and that will appear in selected list. Enter no (starting bus no) in start field 

End: Enter Ending bus number in this field. Bus numbers ended with that number will be available in 
the GUI from the selected GUIs. 

 
 

1.6 Set Menu 
 

The Set menu offers the following commands: 

1.6.1 Set/Modify a Default Line & Fill Style 
 

Use “Set−>Pen & Fill Style” or with a toolbar to set the default line and fill styles to be used while 
drawing objects... The selected choices are highlighted with a radio button style. The selected styles 
and colour can be previewed inside a preview box. The line and fill properties are used as - 

Line style can be set to NULL for not showing a line around the object 

Line style can be set to other styles by clicking a mouse on the choice. The styles are valid only for 1 
pt thickness.; 

Line thickness can be set from 1 to 50. The line thickness 
more than 1 is effective only for a solid line style. 

Line color can be set to any of the RGB mixture value. 

Fill style can be set to NULL for not filling the enclosed 
region. 

Fill style can be set to other styles by clicking a mouse on the choice. 

Fill color can be set to any of the RGB mixture value. 

1.6.2 Set/Modify a Default Text Font 
 

This option is used to set the default 
text font used to write the text inside 
a textbox. The option can be 
selected from the menu item 
“Set−>Text Font”. A general text 
font selection dialog box is shown to 
the user. Choose the options for  
text style, size, colour, etc... and 
select OK to accept the new font, 
and CANCEL to ignore the  
selection. All the text boxes, which 
are added newly to the    document, 
are drawn with the set font. By Default the following options are set for a text font - 

Description Style Name 

Font Arial 

Font Style Regular 

Font Size 9 

Effects - Strikeout FALSE 

Effects - Underline FALSE 

Text Color Navy Blue 
 

Script Western 
 
 
1.6.3 Set/Modify a Default Display Code Font 
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This option is used to set the default text font used to write the text inside a textbox. The option 
can be selected from the menu item “Set−>Display Code Font”.  A general text font selection 
dialog  box is shown to the user. Choose the options for text style, size, colour, etc... and select 
OK to accept the new font, CANCEL to ignore the selection. All the text boxes, which are added 
newly to the document, are drawn with the set font. By Default the following options are set for a 
text font - 

Description Style Name 

Font Times New Roman 

Font Style Regular 

Font Size 9 

Effects - Strikeout FALSE 

Effects - Underline FALSE 

Text Color Navy Blue - RGB(0,0,128) 

Script Western 
 

1.6.4 Set UserDef Font Property 
 

Use this option to set User defined Font. For details Refer section 2.2.7. 

1.6.5 Set/Modify a Mode to Draw Horizontal or Vertical 
Lines (OrthoMode) 

 
This Option is used as a control parameter while drawing an object, object resize and moving 
object(s). The usage is either ON or OFF, If the flag is ON, the status bar pane text is set to 
“Ortho” else the pane is blank. A part of status bar showing the Ortho flag ON is shown in figure. 

Usage while drawing an Object 

When the flag is ON and while drawing a connecting line between any two points, the two points 
are joined by a Horizontal or Vertical line based on whether distance between two points is more 
along  X axis or Y axis. 

Usage while resizing an Object 

When an object is selected for resizing, if user tries to move any handle with the 
mode ON, the handle is moved either along X axis or Y axis based  on  the 
maximum movement is along X axis or Y axis. The rectangle object is redrawn 
as  a square and an ellipse object is redrawn as a circle. 

Usage while moving object(s) 

Select Object or Objects to move only one object or a group of objects. Holding 
down mouse LMB on one of the selected object move the mouse to desired 
location. The selected objects are moved either X or Y direction, depending on 
the maximum amount of X or Y displacement. 

1.6.6 Set an Object Union/ Intersection Mode 
 

This option is used to set mode while selecting the objects for editing. The option can be selected 
from the menu item Set−>Object Union/Intersection. If the option is Object  Union,  then  the 
Objects are selected which are enclosed within a selection rectangle. Else if the option is Object 
intersection, then the objects which are intersect with the selection rectangle are selected in to the 
list. 

1.6.7 Set/Modify Default Background/Paper Colour 
This option is used to set/modify the background/paper colour. The paper colour is used only for the 
usage of viewing and is not available for Printing. The option can be selected from a menu item Set-
>Paper Colour.  When the option is selected, a general-purpose colour selection dialog box is shown 
to the user. Select the desired colour from the already existing selection list OR mix the RGB to the 
desired level. Select OK to accept the selection and CANCEL to ignore the selection. When a new 
colour is accepted for the paper, the application calls the paint message to draw the objects with the 
new paper colour. 
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shown to the user. Select the desired colour from the already existing selection list OR mix the RGB 
to the desired level. Select OK to accept the selection and CANCEL to ignore the selection. When a 
new colour is accepted for the paper, the application calls the paint message to draw the objects  
with the new paper colour. 

1.6.8 Set/Modify Flag to Place the Display Code 
 

This Option is used to place the display code to show the power system 
study results on the single line diagram. The flag can be turned ON/OFF. 
Turn ON the Flag to place the display code for each of the power system 
elements after completing their drawing. For example after establishing the 
connection for a transformer between the two buses the display code is 
placed at the from side and to side to represent the real and reactive power 
flows. Tap display code is placed above the transformer symbol. When the 
user wants to view the particular case results, the code is replaced by the 
numerical value obtained from the power system analysis. 

 
 
1.6.9 Set/Modify Default Object Layer to 

Place New Object(s) 
 

This option is used to set a default layer to which a drawing 
object is to be placed. The option can be selected with a 
menu option “Set−>Object Layer” −>Static, ..... To 
show/hide the objects present in a particular layer refer 
View Layer Objects. 

For, if the default layer is set to General, then all the objects 
added to the document are placed in General layer. 

1.6.10 Set/Modify Document/Paper size 
 

Use this option to set/modify the document size. The option 
is selected with a menu item “Set−>Document Size”. A 
dialog box is shown to the user to enter the new width and 
height  of  the  document  in  the  respective  edit  boxes  in 
pixels. The document origin is at the left-top corner of the screen. The horizontal and vertical scroll 
bars are visible depending on the width and height of the document and the view window. If the view 
window is sufficient to accommodate the whole document, the scroll bars are removed from the 
view. When the width of the document is increased, the document is extended towards right. When 
the height of the document is increased, the document is extended towards bottom. The existing 
document objects positions will not be modified with width or height modification. 

User has the option to set scaling 

Note: If the document size is reduced compared to the previous size, the document objects lying 
outside the document area are not visible. However they are existing in the document. 

By default the document size is set to Width - 850 pixels = 8.50 inches and Height - 1100 pixels = 
11.0 inches 

Options: 

Standard Size: Standard width and Height depending on the selection of paper size 
(A4/A3/A2/A1/A0) will be set. 

User Defined Size: User can specify the width and height of the document. 

Reference Points :User has two options Cartesian and GPS. For Cartesian X and Y coordinates 
details are to be entered 

For GPS co-ordinates Longitude min and max in degree minute and Latitude min and max in degree 
minute are to be entered. 

1.6.11 Set/Modify Distance between Grid Lines, Colour and Line Styles 
 

This option is used to set/modify the grid line style setting. The user can select any RGB colour 
mixture for the grid line. The line style supported for the grid lines are only two, namely, dotted line 
and dashed line. The distance between successive grid lines can be set independently along X and 
Y  direction  in  pixels.  When  OK  is  selected,  the  modifications  are  in  effect.     Otherwise    the 
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modifications are ignored. The grid lines can be toggled from view/hide using the option View−>Grid 
Lines.   When the view grid lines option is ON, then only the grid lines are visible. 

1.6.12 Set/Modify Flag to Zoom the Document 
 

This Option is used to zoom the document along X or Y direction. The flag can be turned ON/OFF. 
Turn ON the Flag to perform real time zooming. Click mouse LMB. The mouse cursor shape is 
changed to zooming mode. Holding down the LMB drag the mouse cursor to the right of the down 
point to increase zooming level. Else to the left of down point to decrease the zooming level. The 
whole document is zoomed to the zooming factor set by the user. The current zoom factor can be 
viewed on the status bar pane. To get the zooming factor of 1.0 (Normal view) double click the 
mouse LMB with the Real time zoom flag ON. To continue working turn OFF the flag. 

1.6.13 Arrow Properties 
 

This option is used to set the width and height of the arrow to be used for lines. When the option is 
selected, a dialog box is shown to the user. Select the Arrow Style to change and change the width 
and height value for it. Switch to other style and modify the values. The modified values are  
accepted once OK button is selected else ignored. By default, all arrow styles have a width of 20 
pixels and height of 6 pixels. 

Arrow Style 

This Option is used to select the arrow style to be used to place on lines. By default the option is set 
to no arrow. Select other than no arrow to draw an arrow along the line based on the arrow location 
specified. The options available with this are Set Arrow to - 

No Arrow 

Triangle Shaped Arrow 

Arrow shaped Arrow 

Ellipse Shaped Arrow 

Diamond Shaped Arrow 

 

1.6.14 Arrow Location 
 

This Option is used to select the location of the arrow on the line drawn. By default the option is set 
to forward. The arrow is placed on a line only if the arrow style is other than No Arrow. 

Select the Location as - 

Forward - to place arrow from Start point towards End point. 

Reverse - to place arrow from End point towards Start point. 

Both - to place arrow along both directions. 

 
 
 

1.6.15 Timer Timings /Text Blinking Frequency 
 

This Option is used to set the text blinking frequency. By default the blinking time is set to 500 milli 
seconds. Edit a new value for blinking time. Select OK to accept the changes and Cancel to ignore 
the changes.  Set the blink on/off using the option Edit −>Text Blink flag. 

1.6.16 Active Contingency 
 

Use “Set−>Active Contingency” to select the contingency. The network is updated and set to the 
selected contingency case. Further any study can be done for this contingency. 

1.6.17 Dynamic Simulation 
 

During the study, it is often required to see what happens if certain system configuration is changed 
(open/close and number of circuits) and see the results immediately, instead of changing the data in 
the database and exclusively solving using solve menu and then plot the results. To obtain this 
objective the Dynamic simulation option is provided. Here you can open, close or change the 
number of circuits for the elements and observe the results immediately. Note that in this case,   the 



MiP-PSCT Power System Network Editor User Manual 

Power Research and Development consultants Pvt. Ltd. Page 52 

 

 

the b 

 

database is not modified and the changes are not saved in the database. If a certain configuration is 
to be saved you can do it by saving it as contingency. The present network configuration will be 
saved in the database as a contingency. The steps to perform dynamic simulation are - 

Open the network. 

Select the required contingency (or may be Base case itself). 

Do the normal load flow and plot the results on the network. 

Select “Set−>Dynamic Simulation”. Initial condition is established and the network 

is Now ready for the action of opening, closing or changing the number of circuits. 

Select an element, right click, selects Element Status open, close or circuits. 

After selection, the results will be plotted on the network. 

At any point of time during simulation you can see the load flow report by 
selecting 

“View−>simulation Report (LFA)” 

The same procedure can be continued for other elements also. 

If a certain configuration is to be saved you can do so, by saving the 
contingency. 

Note: When the dynamic simulation option is set, add/modify/editing of the 
network data or the display attributes is not possible 

1.6.18 PS-End With Bus 
 

This option is selected from main menu Set →PS-End with Bus or click on PS (End with bus / 
without bus) button on tool bar. When     utton is on, power system elements will be connected to  
the buses and the ZZ code with connecting bus numbers will appear along with power system 
elements on the single line diagram. When the button is off elements will not be connected to the 
buses and the ZZ code with zero number will appear on the single line diagram (SLD). 

1.6.19 On Line 
 

Set −>On line > ACD File 

To check this option, follow the steps. 

From main menu select Plot > Load Flow Analysis. 
Browse for the lfa.acd file. 

Set On Line > ACD file. 

If any change in the acd file, will be plotted on the Single 
Line Diagram. 

 
 
1.6.20 Attribute Properties 

 
Use “Set−> Attribute Properties” In this option line and two winding and three winding transformer 
attributes can be set. When the Single line diagram is connected to database, Line Distance and 
Line Type and Transformer rating, % impedance, Units in parallel will appear on the SLD. These 
attributes properties can be set. By using the check box.  Attributes can be show or hide. 

For Line: Option to set line distance in km or meter and Text colour, size and font. Line type font  
can be set. 

For Transformer: Rating can be specified in MVA or KVA. 

Current Transformer: CT ratio of all CTs will appear on SLD 

1.6.21 Substation Code 
 

This is for the network Connected with the database. Select option Set-> Substation Code which  
sets the flag and the buses drawn will take the substation tag for the bus numbers. For details refer 
database manager options->Substation Code. 
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1.7 Change Menu 
 

The Change menu offers following options 

1.7.1 Object(s) Layer 
 

This option is used to change the object layer from one to other. The option can be selected from  
the context menu item “Change−>Layer” −>Static, .....For further details on how to view context 
menu options see context menu. 

1.7.2 Arrow Style 
 

This option is used to change the object Arrow style from one to other. The option can be selected 
from the menu item “Change−>Arrow Style” −>Triangle, or from Context Menu Option  “Arrow 
Style” −>Triangle, for further details on how to view context menu options, see context menu. 

When an option is selected on already drawn line, the line is redrawn with the arrow style selected. 

1.7.3 Arrow Location 
 

This option is used to change the object Arrow location from one to other. The option can be 
selected from the menu item “Change−>Arrow Location” −>Forward, or from Context Menu Option 
“Arrow Location” −>Forward, For further details on how to view context menu options, see context 
menu. When the option is selected on already drawn line, the line is redrawn with the arrow style at 
the specified arrow location. 

1.7.4 Element Status 
 

This option is used to change the element representation from open-close-open-.... The option can 
be selected either from the menu item “Change−>Status”−>Open, Close, From end open, to end 
open, circuits. The same option can be selected through a context menu item “Status”−>Open or 
Close, From end open, to end open, circuits. For further details on how to view context  menu 
options see context menu. When the option Open/Close is selected on already opened/closed 
breaker, the option is ignored. Else the object is redrawn with the new option.  If the status is open it 
is shown in grey\ the element breakers are open. 

 
 
1.7.5 Switching of HVDC Element 

 
This option is used to change the HVDC element representation from rectifier-inverter- rectifier. The 
option can be selected either from the menu item “Change−>HVDC Element”−> rectifier or Inverter. 
The same option can be selected through a context menu item “Change HVDC Element”−> rectifier 
or Inverter. When the option rectifier/Inverter is selected on the rectifier /Inverter, the option is 
ignored.  Else the object is redrawn with the new option. 

1.7.6 Relay Symbol Type 
 

This option is used to change the relay element representation from Directional-Non-Directional- 
Mho-Quadrilateral-Directional. The option can be selected either from the menu item “Change−> 
Relay Symbol Type”−>..... The same option can be selected through the context menu item 
“Change Relay Type” −>.... 

The relay representation can be changed from Directional IDMT to either 

Non-Directional IDMT 

Distance relay with Mho characteristic 

Distance relay with quadrilateral characteristic and vice-versa. 
 

1.7.7 Symbol Type 
 

This option is used to change the symbol representation from Star - Star Grounded – Delta –Ground 
– Breaker Open- Breaker Closed 

The option can be selected either from the menu item “Change−>Symbol Type”−>..... The same 
option can be selected through the context menu item “Change Symbol Type”−>.... 

The symbol representation can be changed from Star to either 
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Star-Grounded 

Delta 

Ground 

Breaker Open 

Breaker Closed and vice-versa. 

1.7.8 Element ID 
Select this option to change the element ID. Element ID is a unique ID which links the network 
elements to the database elements. Care has to take while changing the element number. As far as 
possible avoid changing the ID manually. Always update this from database. 

1.7.9 Relay 
 

Select this option to change the relay type from the existing to any of the following types 

IDMT Over current 

IDMT Earth Fault 

Instantaneous Over current 

Instantaneous Earth fault 

Directional Over current 

Directional Earth fault 

Stand by earth fault 

1.7.10 Bus Data 
 

Enter old Bus No, Bus name, New Bus No and New Bus Name in a text file and save it. Select 
Change−> Bus Data option to change the bus no and bus name in a GUI document. 

1.7.11 Change relay Display Text 
 

Select the relay and then use this option to change the text 
of the relay. A dialog appears with existing text. Enter the 
new text. 

OK: Accepts the change of text and closes the dialog 

Cancel: Closing the dialog without change in the text. 

1.7.12 Meters Connecting Line 
 

Select a meter connecting line in the network and then use this option which opens the Line & Fill 
style dialog.  Required Line style and colour can be changed. 

1.7.13 Relay 
 

Select a relay and can be changed to Over current or Distance or Unit Protection 
Over current Relay IDMT Over current 

 IDMT Earth Fault 
 Inst. Over current 
 Inst Earth Fault 
 Directional IDMT Over current 
 Directional IDMT Earth Fault 
 Stand by Earth Fault 
Distance Relay  
Unit Protection Line Pilot 

 Transformer Differential 
 Restricted Earth Fault 
 Partial Busbar 
 Busbar Differential 
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1.8 Object(s) menu 
 

The Object(s) menu offers the following commands: 

1.8.1 Move Back 
 

This option is used to push a selected object to back by one level. The choice can be selected with 
the menu option “Object−>Move Back”. When more than one object exists one above the other, it 
is very difficult to select an object, which lies at the bottom. With this option the user can select only  
the object just below the selected object. It is not possible to select an object, which lies, more than 
one level below the selected object. 

1.8.2 Move Front 
 

This option is used to push a selected object to front by one level. The choice can be selected with 
the menu option “Object−>Move Front”. When more than one object exists one above the other, it is 
very difficult to select an object, which lies at the bottom. With this option the user can push the 
selected object to one level above. It is not possible to bring an object, which lies, more than one 
level to front. 

1.8.3 Move To Back 
 

This option is used to push a selected object to back of all the overlapped objects. The choice can 
be selected with the menu option “Object−>Move To Back”. When more than one object exists one 
above the other, it is very difficult to select an object, which lies at the bottom. When a top object is 
selected and pushed to the back, the previous object comes to top and the selected object goes to 
the end. 

 
 
1.8.4 Move To Front 

 
This option is used to push a selected object to front of all the overlapped objects. The choice can 
be selected with the menu option “Object−>Move To Front”. When more than one object exists one 
above the other, it is very difficult to select an object, which lies at the bottom. When a bottom object 
is selected and pushed to the front, the previous object goes back and the selected object comes 
front. 

1.8.5 Rotate 
 

This option is used to rotate a selected object(s) by multiples of 90 degrees (i.e., the object can be 
drawn at an angle of 0, 90, 180, 270 degrees). The current drawing object angle can be set with the 
menu option “Object−>Rotate”. The current drawing object angle is shown on the status bar pane. 
When an object is selected for rotation the current object angle at which it is placed in the document 
is updated on to the status bar pane. 

1.8.6 Locate Bus 
 

This option is used to trace a bus through its number or name or any text object. The option can be 
selected with the menu option “Object−>Locate Bus” or through the toolbar. When the option is 
selected, a dialog box is shown to the user to enter a bus number (integer) or a bus name (string) in 
an edit box. As the user starts entering the letters the combo box gets filled up with the names of 
buses and dynamic links. User can select from the combo box The program searches for the bus 
presence in the document. If found the view is scrolled to the position such that the object is at the 
middle of the client area, else the option is ignored. The dialog box buttons are used to trace – 

Object String−>Specify the integer value to search for a bus number. Specify the text to search for 
bus name. If the first button string is “Display string” irrespective of the digit or text, the user value  
is treated as text to search in display code strings. 

Start- Start for locating a bus with a given number or name 

Go To First- Go to beginning of the drawing objects list. 

Next- Trace for the next bus with the same number or name (forward direction). 

Previous- Trace for the previous bus with the same number or name (backward direction) 
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Go To Last - Go to the end of the drawing object list 

Close - End searching operation. 

 
1.8.7 Connect to Bus 

 
The Option is used to connect a selected power system 
object to a bus. At least one selection should be bus. The 
choice can be selected with a menu option Object−>Connect 
to bus 

1.8.8 Disconnect from Buses 
 

The Option is used to dis -connect a selected power system from its buses. After disconnecting from 
the existing buses it can be again reconnected to any other buses. The choice can be selected with  
a menu option Object−>Dis-connect from buses. 

1.8.9 Connect Meters 
 

The Option is used to connect a selected meter object to any 
power system object. Atleast one selection should be Meter. 
The choice can be selected with a menu option 
Object−>Connect Meters. 

 
 
1.8.10 Disconnect Meters 

 
The Option is used to dis -connect selected meters. After disconnecting it can be again reconnected 
to any other meters or power system objects. The choice can be selected with a menu option 
Object−>Dis-connect Meters 

 
 
1.8.11 Associate To PS Element 

 
This option is used to associate any general-purpose drawing element with a power system element 
in the database. 

Select the general-purpose drawing element & on click of this option a dialog will pop up as shown 
below, which displays the entire power system element to which we can associate to the drawing 
element. 

Select the power system element type to which you want to associate the drawing element. On 
selection of the element type, a dialog will pop up which displays the list of selected element type in 
the database as shown. 

Choose the element to which you want to associate the drawing element. 

Note: To associate general purpose drawing element, the GUI document must be connected with 
database & Configure->Draw from database option must be checked. 

1.8.12 Dis Associate from PS Element 
 

This option is used to dis-associate a general purpose drawing object from the database, which is 
associated with the database. 

1.8.13 Rotate Text 
 

This option is selected from main menu Object→Rotate Text->Clockwise or Object→Rotate Text-
>Anticlockwise. This option is used to rotate a text by an angle of 15’, 30’, 45’ and 60’ clockwise or 
anticlockwise with reference to 0’. 
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1.8.14 Update Line Length 
 

Use this option to change the length of associated line in database. Give new line length & save it. 

1.8.15 Align Attributes 
 

When the line or transformer is moved 
attributes remain in original place. Then use 
this option to align the attributes with the 
element (line or transformer). 

1.8.16 Align Attributes in All files 
 

Attributes can be aligned in all opened GUI 
files or in all files which are in the same 
folder 

Aligned GUI files kept open after plotting option is selected 
 

1.8.17 Locate GPS Point 
 

This option is used to locate a GPS 
point in GUI. Give inputs for latitude 
and longitude and click OK It will 
scroll to the particular point on the 
GPS map 

 
 
 
 
 

1.9 Configure 
1.9.1 Configure Base Voltage 

 
Before starting the creation of 
network, the voltage levels in 
the network must be 
configured against the user 
defined colors and bus 
thickness. These colors and 
the thickness are used while 
drawing a bus with a 
specified voltage level. The 
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configuration dialog box is as 
shown below. Keeping the 
voltage levels constant 
against each voltage level, 
the colour code and the 
thickness can be specified. 

 
 

1.9.2 Configure Save Contingency 
 

Steps to create, save and activate a 

contingency is as follows To create and save 

contingency 

Rules: 

Contingency can be saved and activated, only if the network is 
connected to the database. 

Steps: 

Open the single line diagram for which contingency has to be 
created. By default the diagram is in base case where all the 
elements are closed 

 
 

To open an element, select the element click the right 
mouse button the following menu appears 

Select Element Status, 

Open – to open the 

element on both ends 

Close – to close the 

element 

From end open and to end open is valid only for transmission lines. 

Opening of the elements can be done by multiple selections also. Select all 
the elements to be opened, click the mouse right button, and select element 
status and open. All the selected elements will be opened. 

To save contingency – Select Configure→Save Contingency from the main 
menu. Enter appropriate  number  and  name.  Click  OK  to  save   the 
contingency. 

The present contingency number is 
displayed in the  status bar. 

To activate a contingency – Select 
Set→Active contingency from the main 
menu. The following dialog  box 
appears. Select the appropriate case. 
The network is updated and set to the 
selected contingency case. 

The contingency can be created either using the editor or directly from the 
database. In both the cases the set active contingency command works. 

Selection of the contingency case in the database reflects in the single line diagram also. 

The element status is updated accordingly in the network. The contingency 
number is displayed in the status bar 

Change in number of Circuits Contingency 

The number of circuits for the power system element can be changed and saved 
as contingency. The procedure to change the number of circuits is as follows – 

Select the element for which the number of circuits is to be modified (use with control 
key pressed to select only power system elements). 

Right click (holding the control button to select only power system elements), the 
following menu appears. Select Element Status→Circuits. 
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The number of circuits available from the database is displayed. In the Existing 
edit box enter the number of circuits (increase or decrease the number of 
circuits). Click OK to change the number of circuits. 

Change the number of circuits for all the required elements and save it as a contingency. 

To do the study for this contingency, Set→Active Contingency in Network 
Editor, select this contingency, and perform the study. 

 
1.9.3 Configure Sub Database 

 
This option is provided to get the 
sub database for a sub-network 
associated with the central (Main) 
database. This option can be 
used when user wants to create 
individual database for each sub-
network, which was associated 
with centralized database. 

The steps to 

create Sub 

database – 

Open one of the 

sub-network 

Configure > Sub 

Database 

A dialog box appears 

In the Destination edit box database 

name can be changed. Then Click on → 

OK. 

On Ok a message box appears prompting the 
user to open the new database in the database 
manager. 

 
Invoke “Database Manager” and open the newly created database (sub database). 

Select Options → Create Sub Database. The database 
retaining only the specified buses (i.e., the buses available in the 
network) is generated. Close the database. This database can 
be used for analysing the sub network. 

 
 
1.9.4 Configure Draw from Database 

 
Select menu Configure→Draw from Database. This option is used to draw the single line diagram 
for the already existing database. 

 
 
1.9.5 Configure Save Options 

 
This option is used to save the opened file automatically by 
setting the time and Auto Save check box. This option can be set 
by selecting Configure→Save Options. 

 

1.9.6 Configure Standards 
 

This option can be used to view the power system network in 
IEC standards or ANSI standards. This option can be 
selected from main menu Configure → Standards. 
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1.9.7 Configure Network configuration 

 
For details Refer to Chapter 3 section 3.2. In this section 
configure information dialog is explained in detail. 

 
 
1.9.8 Configure Schedule 

 
Select menu Configure→ Schedule. Schedule can be created or 
added by this option. For details refer Chapter 3 section 3.3.2 
configure contingency and schedule 

 
1.10 Plot 
1.10.1 Plot Load Flow Analysis 

 
This Option is used to plot Load analysis  results  on  the  single  line  diagram.  This can be 
selected    with    the    menu    item    “Plot−>Load Flow 
Analysis”. When this is selected, a dialog box is popped 
up to select the different options. 

The different options are - 

Plot File: Plot file can be selected through browse option. 

Results Layer: The   layer   name   to    which   the 
results of the analysis have to be replaced. For example 
if the results layer is General, then the textbox which are 
placed in the layer General and having the display code 
ZZ..... Will be replaced by the corresponding numerical 
value obtained from the study. Voltage display. 

Voltage Unit: Voltage Unit for display. Select kV/Angle or 
PU/Angle 

Precision: Number of characters to be used for voltage display. By default 6 characters are used 
which includes the dot operator. 

 

Low Value Colour: If the voltage value goes below the low value, then the voltage value is displayed 
with the colour specified. This gives an indication to the user about low voltage bus(s). Double click 
mouse LMB to configure a different colour for it. 

Normal Value Colour: If the voltage value lies within the low value and high value, then the voltage 
value is displayed with the colour specified. This gives an indication to the user about normal voltage 
bus(s). Double click mouse LMB to configure a different colour for it. 

High Value Colour: If the voltage value goes above the high value, then the voltage value is 
displayed with the colour specified. This gives an indication to the user about high voltage bus(s). 
Double click mouse LMB to configure a different colour for it. 

Magnitude option and angle option are provided either to plot the magnitude and angle or not. 

Power Flow Display 

Flow Unit: Power flow Unit for display. Select MW/Mvar, MVA/Angle, Amp/Angle, Impedance R/X, 
Kw/Kvar or Kva/Angle. 

Precision: Number of characters to be used for power flow display. By default 6 characters are used 
which includes the dot operator. 

Low Value Colour: If the MVA loading of the line is below 25%, then the power flow value is 
displayed with the colour specified. This gives an indication to the user about lightly loaded lines. 
Double click mouse LMB to configure a different colour for it. 

Normal Value Colour: If the MVA loading of the line is between 25% and 100%, then the power flow 
value is displayed with the colour specified. This gives an indication to the user about normally 
loaded lines.  Double click mouse LMB to configure a different colour for it. 

High Value Colour: If the MVA loading of the line is above 100%, then the power flow value is 
displayed with the colour specified. This gives an indication to the user about heavily loaded lines 
Double click mouse LMB to configure a different colour for it. 

From P and Q and To P and Q and Loss P and Q options provided to select which flows are to be 
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plotted on to the network. Any combination can be selected. 
 

About Display codes in details 
Table 1: Display Codes for Load Flow and Fault Analysis 

 
SN Code Load Flow Analysis Fault Analysis 

 1. ZZVMx Voltage magnitude in pu at bus ‘x’. Fault level magnitude or 
post fault bus voltage 
magnitude in PU 

2. ZZVAx Voltage angle in degrees at bus ‘x’. Fault level angle/voltage 
angle 

3. ZZLPx-y P flow from node x to node y. Forward fault flow 
magnitude 

4. ZZLQx-y Q flow from node x to node y Forward fault flow angle in 
degrees. 

5. ZZLPy-x P flow from node y to node x Reverse fault flow 
magnitude. 

6. ZZLQy-x Q flow from node y to node x Reverse fault flow angle in 
degrees. 

7. ZZLLx-y Line loading from node x to y - 
8. ZZLTx-y Transformer tap - 
8. ZZGPx Generator real power at node x Fault quantity injected  to 

bus x by generator. 
9. ZZGQx Generator reactive power at node x Fault angle in degrees. 
10. ZZDPx Load real power at node x Fault quantity injected  to 

bus x by load. 
11. ZZDQx Load reactive power at node x Fault angle in degrees. 
12. ZZDCx Load compensation at node x - 
13. ZZCPx Capacitor real power at node x Fault quantity injected  to 

bus x by capacitor. 
14. ZZCQx Capacitor reactive at node x Fault angle in degrees. 
15. ZZRPx Inductor real power at node x Fault quantity injected  to 

bus x by inductor. 
16. ZZRQx Inductor reactive power at node x Fault angle in degrees. 
17. ZZHVx HVDC converter voltage - 

 18. ZZHPx HVDC real power Fault quantity injected  to 
bus x  by HVDC. 

 
19. ZZHQx HVDC reactive power Fault angle in degrees. 
20. ZZHTx HVDC transformer tap - 
21. ZZKPx-y DC power from x to y - 
22. ZZKCx-y DC current from x to y - 
23. ZZKPy-x DC power from y to x - 
24. ZZKCy-x DC current from y to x - 
25. ZZFISLAND 

n 
Frequency of island n computed  
from load flow. 

- 

26. ZZGPT Total real power generation - 
27. ZZGQT Total reactive power generation - 
28. ZZRPT Total shunt reactor real power 

injection 
- 

29. ZZRQT Total shunt reactor reactive power 
injection 

 

30 ZZCPT Total shunt capacitor real power 
injection 

- 

 
Note: 

If T in the above list (26-30) is followed by n, where n is the  zone  number,  value  refers  to 
particular zone. ex., ZZDPT5 gives the total real power load for zone 5. 

If more than one line is connected between two buses the code should be written in the following 
way - 

ZZLPx-y(n) where n is the line number starting from the first line connected between the buses x 
and y 

 
 

If the three phase load flow or harmonic analysis results are to be superimposed on the single line 
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diagram, ZZ is followed by phase or sequence value index as below: 

 
A A Phase ZZAVMx 
B B Phase ZZBVMx 
C C Phase ZZCVMx 
1 Positive sequence ZZ1VMx 
2 Negative sequence. ZZ2VMx 
0 Zero sequence ZZ0VMx 

Table 2: Display Codes for Relay Co-ordination 
 

SN Code Relay Co-ordination 

1. ZZPPSrname Phase plug setting in amperes. 
2. ZZPTSrname Phase time dial setting. 
3. ZZPISrname Phase instantaneous setting in amperes. 
4. ZZEPSrname Earth plug setting in amperes. 
5. ZZETSrname Earth time dial setting. 
6. ZZEISrname Earth instantaneous setting in amperes. 
7. ZZPFCrname Phase fault current sensed by the relay. 
8. ZZEFCrname Earth fault current sensed by the relay. 
9. ZZPOTrname Phase fault operating time. 
10. ZZEOTrname Earth fault operating time . 

Note: where 'rname' is the relay name. The fault current sensed by the relay and operating times 
for these currents are generated only if the simulation option is greater than 1. 

 
 

Table 3: Display Codes for Notation used for display 
 

SN Code Load Flow Analysis Short Circuit studies 

1. ZZNOTE1 Display Notation Display Notation 
2. ZZNOTE2 Sign convention for injection into bus Fault level at bus 
3. ZZNOTE3 Sign convention for drawl from bus Fault contribution 
4. ZZNOTE4 Voltage magnitude and angle units Fault level units 

 5. ZZNOTE5 Line flow units Fault contribution units  
 
1.10.2 Plot Short Circuit Study 

 
After the execution of short circuit study, results can be 
plotted on the SLD. Either Fault MVA or Fault current can 
be plotted. 

Summary Checked: Summery will be plotted 

Voltage Unit display: Voltage Unit for display. Select kV/Angle or PU/Angle 

Precision: Number of characters to be used for voltage display. 

Voltage display. By default 6 characters are used which includes the dot operator. 

Flow in Kilo units : Line flow and bus flow in kilo units displayed in SLD 

Fault Level threshold: Set the threshold value Flows exceeding the threshold value displayed in 
red colour. Flows below threshold value displayed in green colour. 

 

1.10.3 Plot Relay Co-ordination 
 

This option is used to plot the Relay Co-ordination 
study results by selecting “.acd” file. Phase and earth 
relay settings of Current and time in different colour 
can be plotted on SLD 

Plot File: From browse select the .acd file which is 
stored in ORCD folder. By default this file is selected 
by the program 

Results Layer: Normally static layer from the drop 
down list is to be selected for plotting the results. By 
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default program will selects the static layer 

Display: Phase and Earth: User has an option to plot 
relay co-ordination results for Phase co-ordination and 
Earth Co-ordination 

Units: This can be on / off 

Phase setting Display and Earth setting Display : 
Current and time settings for phase and earth can be 
plotted on the diagram(GUI). Current and Time 
display colours can be set by the user 

Precision: Number of characters to be used for 
power flow display. By default 6 characters are used 
which includes the dot operator. 

Ok: Closes the dialog and plot the results on GUI 

Cancel: Closes the dialog without plotting 
 
 
1.10.4 Plot Harmonic Analysis 

 
This option is used to plot the harmonic study 
results by selecting  “.acd” file 

Total harmonic distortion factors for different 
buses will be plotted on the GUI 

1.10.5 Plot Reliability Indices 
 

This option is used to plot the reliability study 
results. This option is used to plot the 
Reliability study results by selecting  “.acd” 
file 
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1.10.6 Plot Three phase Load Flow 
 

Plot option is similar to Load flow study plotting. 

Phase Display: Selected phase (Phase A or Phase B or Phase C) results will be displayed Voltage 
display. 

Voltage Unit: Voltage Unit for display. Select kV/Angle or PU/Angle 

Precision: Number of characters to be used for voltage display. By default 6 characters are used which 
includes the dot operator. 

Low Value Colour : If the voltage value goes below the low value, then the voltage value is  displayed 
with the colour specified. This gives an indication to the user about low voltage bus(s). Double click 
mouse LMB to configure a different colour for it. 

 

 
 

Normal Value Colour: If the voltage value lies within the low value 
and high value, then the voltage value is displayed with the colour 
specified. This gives an indication to the user about  normal voltage 
bus(s). Double click mouse LMB to configure a different colour for it. 

High Value Colour: If the voltage value goes above the high value, 
then the voltage value is displayed with the colour specified. This 
gives an indication to the user about high voltage bus(s). Double 
click mouse LMB to configure a different colour  for it. 

Magnitude option and angle option are provided either to plot the 
magnitude and angle or not. 

Power Flow Display 

Flow Unit : Power flow Unit for display. Select MW/Mvar, MVA/Angle, Amp/Angle, Impedance R/X, 
Kw/Kvar or Kva/Angle. 

Precision Number of characters to be used for power flow display. By default 6 characters are used 
which includes the dot operator. 

Low Value Colour: If the MVA loading of the line is below 25%, then the power flow value is displayed 
with the colour specified. This gives an indication to the user about lightly loaded lines. Double click 
mouse LMB to configure a different colour for it. 

Normal Value Colour: If the MVA loading of the line is between 25% and 100%, then the power flow 
value is displayed with the colour specified. This gives an indication to the user about normally loaded 
lines.  Double click mouse LMB to configure a different colour for it. 

High Value Colour: If the MVA loading of the line is above 100%, then the power flow value is 
displayed with the colour specified. This gives an indication to the user about heavily loaded lines 
Double click mouse LMB to configure a different colour for it. 

 
1.10.7 Plot All Files 

 

An option to plot the results in all the open GUI’s or GUI’s in a directory is provided. This option will be 
useful when there are many sub-networks associated with the same database (in the current version 
database association is not checked). 
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Select the menu option Plot →Plot All files 

A dialog box appears 

All the networks present in the directory will be listed. Add the files wherein load flow results are to be 
plotted. 

Files in a Directory: Study results will be plotted in the selected files presented in the directory 

Open Files Only: Study results will be plotted in the files, which are currently open. 

Keep the Files open after plotting: Check this to keep the files open after plotting the results. 

Uncheck to close the files after plotting the results. The currently active file will not be closed. 

Study: User can select required study results to be plotted in the selected files. 

Click on 

Add – to add a file from the Files list box to Selected Files list box. 

Add All – to add all the files to Selected Files list box. 

Remove – to remove a file from Selected Files list box. 

Remove All – to remove all the files from Selected Files list box. 

OK – to plot the results 

Cancel – to cancel the plotting 

1.11 Database 
1.11.1 Database Configure 

 
The steps involved to associate and work 
with the database from the network editor is 
as follows – 

Before starting the new single line  diagram, 
select Database→Configure 

When configure is selected the following 
dialog box appears. Browse to the desired 
directory and specify the name of the 
database to be associated with this single 
line diagram 

A database with user defined name is created. Configure the 
Electrical information (refer database manager manual for 
further details). Click OK. 

In the Network Editor, configure the base voltages for the single 
line diagram. 

Standard Library check boxes are provided. If they are checked standard libraries (transmission lines, 
transformers, generators and Relay libraries) are included in the new database. 

Start drawing the network. On completion of drawing an element a dialog box prompting the user for 
the element ID appears. Enter the element ID. 

Rules 

Each element of a particular type should have unique ID. (eg. No two different transformers shall have 
same ID). 

Two elements of same type can have identical ID’s in a network when the two elements are physically 
same but for presentation purpose is drawn at two different locations. In this case there will be only 
one data in the database 

Two different types of elements can have same ID (eg. A line and a transformer can have same ID 
number) 

Once the element ID is given and corresponding data is updated in the database, do not change the 
element ID. If the ID is changed the link between the database and the element for which the ID is 
changed will be lost. 

Click OK. If the database is connected, the corresponding form appears. The data that is passed to 
the database from the network is grayed. It is not possible to edit that data. For example, if a 
transformer is drawn, the transformer form appears in add mode. The element number, from bus 
and to bus is grayed as shown below. Enter the remaining data. Enter the library details also (for 
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details refer: database manager manual). Save the record. After saving an element record the  
control is transferred back to network editor. But when a library is saved the To Network button on 
the bottom toolbar should be selected to pass control back to the network editor. 

Draw the remaining diagram, the above step is repeated for each element. 

To edit: Double click on the element. Corresponding data form appears. Modify if required and save. 
Note: To edit bus data, hold down CTRL key and double click. 

To Delete: Select the element and select delete from the edit menu. If a corresponding element 
exists in the database, the user is prompted with the message “Delete this record ?”. Chose the 

required response. Note that the element may be present in the database but not in the single line 
diagram or vice versa. 

To associate an existing database with an existing single line diagram. 

Rules: 

The bus numbers in the single line diagram should be proper. Check the bus numbers associated 
with each bus. 

The elements should be actually connected between the two buses. (There is a possibility that only 
representation is done without actually connecting it to the buses). If not connected, the element ID 
will be set to 0. 

Steps: 

Open the single line diagram 

Configure the database, by selecting the existing database. This 
will automatically connect to the database. 

In Database Manager, select Options→Update Network from the 
main menu. The following dialog box appears. Click on start to update the network, OK to close the 
dialog box. When updating is completed a message appears. Click Ok. Now check the elements for 
the element ID’s. All elements ID’s will be updated. If not updated, check the bus numbers and 
connectivity information. 

 

1.11.2 Database Connect 
 

When the network is configured and a database is associated select this option connects to explicitly 
connect to the database. Network will get connected to the database automatically even if this  
option is not selected 

1.11.3 Database Disconnect 
 

When the network is configured and a database 
is associated, select this option disconnects to 
explicitly disconnect from the database. 

1.11.4 Set All 
 

This option is provided to set the database name 
for many sub-networks associated with the same 
database. This option can be used when all the 
networks and database are copied to a new 
location or when a different database is to be 
associated with many sub-networks. 

The steps to modify the database name are – 

Open one of the sub-networks 

Configure new/modified database 

Select – Database – Set All 

The following dialog box appears 

Select the files for which the database name is to be modified. 
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Click on 

Add – To add a file to the Selected Files list box 

Add All – To add all the files to the Selected Files list box 

Remove – To remove a file from Selected Files list box 

Remove All - To remove all the files from Selected Files list box 

Ok - to modify the database associated with the selected networks 

Cancel – to cancel the database name association modification operation. 

1.11.5 Copy Libraries 
 

This option is used to copy libraries from one database to another database. For this GUI should be 
connected with database. For details refer Database manager (chapter 3) menu options-> Database 
>> Copy libraries 

1.12 Solve Menu 
 

The following power system study can be performed through power system network editor 

• Load flow analysis 

• Short circuit study 

• Over current relay co-ordination 

• Distance relay co-ordination 

• Transient stability 

• Dynamic stability 

• Sub-synchronous resonance 

• Network reduction 

• Voltage Instability 

• Harmonic Analysis 

• Electromagnetic transient analysis 

• Three phase load flow analysis 

• Reliability Indices 

• Observability Analysis 

• State Estimation 

• Arc Flash Analysis 

For details, please refer Database Manager - Solve Menu 

1.13 Tool Menu 
 

• For the following option details refer chapter Database Manager - Tools Menu 

• Present Worth 

• Cost analysis 

• MIS 

• Batch Mode load flow analysis 

• Batch mode contingency creation 

• Batch mode for load curves 

• Distribution Analysis 

• Energy loss computations 

• Update Breaker ratings 

• Update De-rated MVA Rating 
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• Update Real Time data 

• Transformer Check 

• View 

• Report Writer 
 

1.13.1 GPS Interface 
 

This option helps to draw the single line diagram according to geographical positioning of points and 
draw the network.  Select from the main menu Tool --> GPS. Following dialog will open. 

GPS diagram can be generated from GPS file or from the database. 

Generate from database 

Open the GUI and configure the database 
which have GPS coordinates 

Set menu, Option->Document Size->Select 
GPS radio button-> select document size  
as per the requirements and enter the 
maximum and minimum values of latitude 
and longitude ->click on ok 

 
 

Select GPS interface-> Generate from DB 
option 

Check Show connection option in order to 
show line and load connection otherwise 
only buses will be displayed 

 
 

Select Bus name or number to be displayed 
in GUI and execute 

To locate a GPS Point: Select menu 
Objects->Locate GPS Point. Give inputs for 
latitude and longitude->ok. It will scroll to  
the particular latitude and longitude. 

Bus and Load Symbol Reference: for symbol selection option for font no, colour and ratio set from 
the existing library. For details refer section 2.2.7 and 2.2.8. 

Line Distance: It gives distance between the two points by calculating the distance from GPS 
coordinates 

Generate From file will have following procedure 

Open a new GUI file 

Browse for GPS input file, Connection data file and load data file 

Give no of pixels/km 

Select Load symbol reference 

Execute and Click on GUI button to view the network. 

GPS Input File: Browse for the GPS input file. Edit will open the file. Sample File format is given 
below 
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Connection 

Data file: Browse for the connection data file. Sample file format is given below. 

The first line represents the number of connection points. 

The name of the from and to connection points as in the GPS input 

file 4 

 
 
 
 
 
 
 
 

Load Data File: Browse for the load data file. Sample file format is given 

below Pole No DTC MW MVAR 

 
 
 
 
 
 
 
 

Save: Changes will be saved. 

Font symbol, Font colour, ratio can be modified. 
No of pixels/km and reference shift along X and 
Y can be given. All these details can be saved by 
clicking Save button 

Execute: Click this button opens a dialog as 
shown below. Click OK 

Done: It takes the control to GUI 

File Format: Opens the GPS file format details 
file. 

1.13.2 Draw Reference Points 
 

This option is used for distribution network. To 
use this option follow the given steps. 

Open new GUI document 

Configure database to the GUI document 

Select Configure > Draw from database option from main menu 

By using free hand tool place a point on the gui document and associate with database 

element. Now select Tool > Draw Reference point option. Following dialog will open 

From Pole To Pole Line Library No 

P1 P2 2 

P2 P3 2 

P3 P4 2 

P4 P5 2 

 

P31 DTC-1 212.5 131.695 

P34 DTC-2 212.5 131.695 

P40 DTC-3 85 52.678 

P42 DTC-4 85 52.678 

P44 DTC-5 212.5 131.695 
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Number of Nodes: Enter number of points or buses. 

Starting node number: Enter starting node number 

Distance between each node: Enter distance between each node in pixels. 

Direction of node placement: select direction of node placement with the given option 
 

Get distance from database: Check this to get distance on GUI document. Click OK button to  
place the references points on GUI document. 

 
 
 
 
 

 
1.13.3 Draw Distribution Network 
 

After placing the reference points on the GUI document select Tool > Distribution Network 
option to draw the network. Following dialog will appear. Click OK button. Distribution network with 
distance will appear on the GUI document. 

1.13.4 Switching Optimization 
 

Consider closed distribution network. Select switching optimization option, which shows which 
line,  is to be opened. 

1.13.5 Description 
 

Select this option from Tool-> Description. Following dialog will 
open. Enter the details of the network and click OK button. 

 
 
1.13.6 Draw from File 

 
Provide network elements coordinates in a text file. Then 
select Tool-> Draw From File to draw the network. 

1.13.7 Change Draw Text File 
 

To modify the contents of the Draw text file use this option. 
 
 
1.13.8 Change Element IDs 

 
This option is used to modify the power system element  
IDs present in the active GUI document. Give the offset 
(starting) value and then click OK button. 

 
 
1.13.9 Generate ZZ codes 

 
This option will list the ZZ codes for the power system 
elements present on the active GUI document. Select the 
appropriate generated code and place it on the element. 
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This is useful when No of GUIs with NOPs is more and 
link them. Same lines with connected buses are in 
different GUIs with the same database. 

Configure the GUI with database. From tool select 
menu option Tool->Create Dynamic links to NOPs. 
Following dialog with listing of all GUIs present in that 
folder. 

           
          

       

             

 
 
 
1.13.10 Create Dynamic Links to NOP’s 

 
 
 
 
 
 
 
 
 
 
 

Add All: Adds all files from file list box to Selected files List box 

Remove: Removes a file from Selected files list box 

Remove All: Removes all files from selected files list box 

OK: Updates the changes and closes the dialog 

Cancel: Closes the dialog without updates 

Refer Database manager (Chapter 3) menu Tools->Automatic normal opening point creation 
 

1.13.11 Update Dynamic Link 
 

Update dynamic Links: After creating dynamic links, select Tool->Update dynamic link. a text box 
appears on the GUI with File name. Double click on the text box will open the GUI with NOP 

Refer Database Manager (Chapter 3) Menu Tools->Update NOP 
 
 
1.13.12 Elements Not Connected to Database 

 
To use this option select a gui and configure it to database. Select 
option Tools-> Elements Not Connected to Database. This shows 
the list of elements which are present only in GUI and not in 
database. 

 
 
1.13.13 Unit Protection 

 
The following unit protection study can be performed through power system network editor. 

Transformer Differential 

Restricted Earth Fault 

Line Pilot 

Bus Bar Differential 

Line Differential 

Protection Report 

 

These topics are covered in detail in Database Manager Chapter-3 Menu Unit Protection 
 

1.13.14 Protection Simulation: 
 

Over current co-ordination can be simulated and the relays tripping sequence can be viewed on 
SLD. Relay Network which is connected to the database, right click on the bus from the drop down 
list select Protection Simulation which opens the Fault Data screen 
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Simulation: Existing or proposed settings to be considered for simulation 

Fault Current option: Program considers by default, computed settings for simulation. For user 
given fault current also simulation can be done. 

Fault Type: Three phase, SLG, LL or LLG fault can be selected from the drop down list 

Plot: PhaseA, PhaseB, PhaseC, positive sequence, Negative sequence or Neutral can be 
selected from the drop down list. Element Property window with CT, Relay details and Relay trip 
sequence tracking will appear on Network (SLD) as shown below. After the relay operation, 
tripped section appears in grey colour. 

 

 
 

1.13.15 Fault Simulation: 
 

Short circuit analysis for the selected bus can be executed and 
plotted on the SLD. Right click on any bus from the drop down list. 
Select Fault simulation which opens the Fault simulation window. 
Select fault type and plot option from the drop down list. Then 
click OK button which simulates SCS and plot the results on SLD 
showing fault  symbol at the faulted bus. Option is provided for 
user given fault current simulation and computed fault current 
simulation. 

Select line and right click which opens the fault simulation window 
with fault at a distance field enabled. User has the option to enter 
% of the line to simulate short circuit studies. 

 
 
1.13.16 Disturbance Analysis (Single file analysis): 

 
Single file analysis (disturbance analysis) procedure is explained in the following steps 

1. Select the .GUI file from the data folder. The following screen appears: 
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2. GUI file opens   Configure the database by selecting menu option Database-> Configure. 
 

 
3. Here select a Relay and right click and select Disturbance analysis. Following dialog opens. Browse 

for .cfg file. Select phase voltage and current for channel mapping 

4. Save the options and click on Single File Analysis button. 
 

 

1. Browse 
for   the 

2.  Click  here for 
channel mapping 

3.   Save  the 
selection 

4.  Click  here for 
analysis 
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5. The following screen appears. Click on Report Viewer. 

6. The report file opens as shown below. 
 

Click  here  for 
Report Viewer 
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1.13.17 Copy & Paste Network and Database 
 

Elements: 
 

This option is to be used for the network 
connected with database. Select the network to 
be copied and right click the mouse button and 
select copy option or Ctrl+C. Then click on the 
screen and right click the mouse button and 
select paste-Network and database option as 
shown below. Copied object will be pasted  at 
the curser point. 

Change element ID’s dialog appears. If the 
option is Default, element ID’s will be given by 
the program. If the option is user defined,    then 
the ID’s will be taken from the offset value specified by the user. 

Substation: Substation code for the selected buses can be replaced which were entered in Bus no. 
fields (from, to, new code i.e. value). Like that element IDs can be changed 

Replace: Type the substation name which can be replaced by new name which is to be typed in by 
text box. It replaces Bus names and element names 

OK: Updates the selection and closes the window 

Cancel: Without changes close the window. 

Network with new element ID’s copied to GUI 
file and also the database is updated with  
copied elements. 

Partial Analysis 

This option will be useful when there are many 
sub-networks associated with the same 
database. 

Over Current Relay co-ordination can be 
simulated for selected relays or over current 
relays present in the opened network. Option is 
there to select all relays present in the  
database. Graph option is there to view phase 
relay curves or earth export:  Opens  Over 
current relay coordination report 

 
 

Custom Report: Opens custom report 

Execute: Relay co-ordination program will be 
executed 

Graph: Co-ordination graph can be plotted 

OK – To simulate the relay co-ordination 

Cancel – To cancel the simulation 

 

1.14 Quick Solve 
 

Following studies can be executed from this menu option and results will be plotted after the 
execution. This option can be obtained from control menu option (i.e. hold control and select a bus) 
of a bus and then right click RMB (Right Mouse button) from the list select Quick Solve option. 

Load flow: Load flow will be executed with the options provided in LFA study info screen and the 
results are plotted on the SLD. This option will take last load flow case options 

Short Circuit Study: Short Circuit study will be executed with the options provided in SCS study 
info screen and output options and the results are plotted on the SLD 

Relay Co-ordination: Over current and Distance relay co-ordination can be executed without going 
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to Study Information screen and the results are plotted on SLD 

1.14.1 Window Menu 
 

The Window menu offers the following commands, which enable you to arrange multiple views of 
multiple documents in the application window. 

1.14.2 New command 
 

Use “Window−> New” to open a new window with the same contents as the active window. You  
can open multiple document windows to display different parts or views of a document at the same 
time. If you change the contents in one window, all other windows containing the same document 
reflect those changes. When you open a new window, it becomes the active window and is 
displayed on top of all other open windows. 

1.14.3 Cascade command 
 

Use “Window−> Cascade” command to arrange multiple opened windows in an overlapped  
fashion. 

1.14.4 Tile command 
 

Use “Window−> Tile” this command to arrange multiple opened windows in a non-overlapped 
fashion. 

1.14.5 Arrange Icons Command 
 

Use “Window−> Arrange Icons” to arrange the icons for minimized windows at the bottom of the 
main window. If there is an open document window at the bottom of the main window, then some or 
all of the icons may not be visible because they will be underneath this document window. 

1.14.6 Window 1, 2... 
 

MiGUI displays a list of currently open document windows at the bottom of the Window menu. A 
check mark appears in front of the document name of the active window. Choose a document from 
this list to make its window active. 

1.15 Help 
 

To explore help provided in the Power system Network editor, use menu options “Help  −> 
Help Topics”  
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